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Preface
Welcome to the Genesys Voice Platform 8.0 Deployment Guide. This 
document provides detailed installation and configuration instructions for 
Genesys Voice Platform (GVP).
This document is valid only for the 8.0 release.

Note: For documents created for other releases of this product, please visit 
the Genesys Technical Support website, or request the Documentation 
Library DVD, which you can order by e-mail from Genesys Order 
Management at orderman@genesyslab.com.

This preface provides an overview of this document, identifies the primary 
audience, introduces document conventions, and lists related reference 
information. It contains the following sections:

Intended Audience, page 10
Chapter Summaries, page 10
Document Conventions, page 11
Related Resources, page 13
Making Comments on This Document, page 14

GVP is a group of software components that constitute a robust, carrier-grade 
voice processing platform. GVP unifies voice and web technologies to provide 
a complete solution for customer self-service or assisted service.
In the Voice Platform Solution (VPS), GVP 8.0 is fully integrated with the 
Genesys Management Framework. GVP uses the Genesys Administrator, the 
standard Genesys configuration and management Graphical User Interface 
(GUI), to configure, tune, activate, and manage GVP processes and GVP voice 
and call control applications. GVP interacts with other Genesys components 
and can be deployed in conjunction with other solutions, such as Enterprise 
Routing Solution (ERS), Network Routing Solution (NRS), and 
Network-based Contact Solution (NbCS).

mailto:orderman@genesyslab.com
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Intended Audience
This document is primarily intended for system integrators and administrators. 
It is written with the assumption that you have a basic understanding of:
• Computer-Telephony Integration (CTI) concepts, processes, terminology, 

and applications.
• Network design and operation.
• Your own network configurations.
You should also be familiar with the Genesys Framework architecture.

Chapter Summaries
In addition to this preface, this Deployment Guide contains the following 
chapters and appendixes:
• Part 1: “Planning” on page 15

Chapter 1, “GVP Architecture,” on page 17, describes the primary 
components and basic architecture of GVP.
Chapter 2, “Prerequisites and Planning,” on page 41, describes the 
prerequisites and planning considerations for deploying GVP. It 
includes information about required software and recommended 
hardware.

• Part 2: “Installation” on page 49
Chapter 3, “Deployment Task Summary,” on page 51, summarizes the 
tasks required to deploy GVP 8.0 on Windows hosts.
Chapter 4, “Preparing Your Environment,” on page 55, describes how 
to optimize the Windows host services, web browser, and system 
performance settings.
Chapter 5, “Installing GVP Manually,” on page 59, describes how to 
install GVP 8.0 manually, using the executable files and completing 
basic configuration in Genesys Administrator.
Chapter 6, “Post-Installation Activities on the GVP Hosts,” on 
page 81, describes how to provision the GVP components, create the 
Reporting Server database, and how to stop and start the GVP 
processes.

• Part 3: “Appendixes” on page 123.
Appendix A, “Installing GVP Using the Deployment Tool,” on 
page 125, describes how to install GVP by using the Genesys 
Administrator Deployment tool.
Appendix B, “NLB Clustering for Resource Manager,” on page 137, 
describes how to set up and configure a Network Load Balancing 
(NLB) Cluster for Resource Manager to facilitate scalability, 
redundancy, and availability.
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Appendix C, “External SIP Resources,” on page 149, describes how to 
configure the Genesys Voice Platform to include external SIP 
resources.

Document Conventions
This Deployment Guide uses certain stylistic and typographical conventions—
introduced here—that serve as shorthand for particular kinds of information.

Document Version Number

A version number appears at the bottom of the inside front cover of this 
document. Version numbers change as new information is added to this 
document. Here is a sample version number:

72fr_ref_09-2005_v7.2.000.00 

You need this number when you are talking with Genesys Technical Support 
about this product.

Typeface Styles

Italics

In this document, italics is used for emphasis, for document titles, for 
definitions of (or first references to) unfamiliar terms, and for mathematical 
variables.

Examples: • Consult the Genesys 8.0 Migration Guide for more information.
• A customary and usual practice is one that is widely accepted and used 

within a particular industry or profession.
• Do not use this value for this option.
• The formula, x +1 = 7 where x stands for . . .

Monospace Font

A monospace font, such as teletype or typewriter text, is used for all 
programming identifiers and GUI elements. 
This convention includes the names of directories, files, folders, configuration 
objects, paths, scripts, dialog boxes, options, fields, text and list boxes, 
operational modes, all buttons (including radio buttons), check boxes, 
commands, tabs, CTI events and error messages; the values of options; logical 
arguments and command syntax; and code samples.

Examples: • Select the Show variables on screen check box.
• Click the Summation button.
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• In the Properties dialog box, enter the value for the host server in your 
environment.

• In the Operand text box, enter your formula.
• Click OK to exit the Properties dialog box.
• The following table presents the complete set of error messages T-Server® 

distributes in EventError events.
• If you select true for the inbound-bsns-calls option, all established 

inbound calls on a local agent are considered business calls.
Monospace is also used for text that users must enter manually during a 
configuration or installation procedure, or on a command line:

Example: • Enter exit on the command line.

Screen Captures Used in This Document

Screen captures from the product GUI, as used in this document, may 
sometimes contain a minor spelling, capitalization, or grammatical error. The 
text accompanying and explaining the screen captures corrects such errors 
except when such a correction prevents you from installing, configuring, or 
successfully using the product. For example, if the name of an option contains 
a usage error, the name would be presented exactly as it appears in the product 
GUI; the error would not be corrected in any accompanying text.

Square Brackets

Square brackets indicate that a particular parameter or value is optional within 
a logical argument, a command, or some programming syntax. That is, the 
parameter’s or value’s presence is not required to resolve the argument, 
command, or block of code. The user decides whether to include this optional 
information. Here is a sample:
smcp_server -host [/flags]

Angle Brackets

Angle brackets indicate a placeholder for a value that the user must specify. 
This might be a DN or port number specific to your enterprise. Here is a 
sample:
smcp_server -host <confighost>
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Related Resources
Consult the following additional resources as necessary:
• Genesys Voice Platform 8.0 User’s Guide, which provides information 

about the configuring, provisioning, and monitoring of GVP and its 
components.

• Genesys Voice Platform 8.0 VoiceXML 2.1 Help, which provides 
information about developing VoiceXML applications. It presents 
VoiceXML concepts and provides examples that focus on the GVP 
implementation of VoiceXML.

• Genesys Voice Platform 8.0 CCXML Reference Manual, which provides 
information about developing CCXML applications for GVP.

• Genesys Voice Platform 8.0 Troubleshooting Guide, which provides 
information about SNMP MIBs and traps for GVP, as well as 
troubleshooting methodology.

• Voice Platform Solution 8.0 Integration Guide, which provides information 
about integrating GVP 8.0 and SIP Server 7.6.

• Composer Voice 8.0 Deployment Guide, which provides installation and 
configuration instructions for Composer Voice.

• Composer Voice 8.0 Help, which provides online information about using 
Composer Voice, a GUI for the development of applications based on 
VoiceXML and CCXML. 

• W3C Voice Extensible Markup Language (VoiceXML) 2.1, W3C 
Recommendation 19 June 2007, which is the W3C VoiceXML 
specification that GVP supports.

• W3C Speech Synthesis Markup Language (SSML) Version 1.0, 
Recommendation 7 September 2004, which is the W3C SSML 
specification that GVP supports.

• W3C Voice Browser Call Control: CCXML Version 1.0, W3C Working 
Draft 29 June 2005, which is the W3C CCXML specification that GVP 
supports.

• W3C Voice Extensible Markup Language (VoiceXML) 2.0, W3C 
Recommendation 16 March 2004, which is the W3C VoiceXML 
specification that GVP supports.

• Genesys Voice Platform 8.0 Configuration Options Reference, which 
replicates the metadata available in the Genesys provisioning GUI to 
provide information about all the GVP configuration options, including 
descriptions, syntax, valid values, and default values.

• Genesys Voice Platform 8.0 Metrics Reference, which provides 
information about all the GVP metrics (VoiceXML and CCXML 
application event logs), including descriptions, format, logging level, 
source component, and metric ID.
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• Framework 8.0 Deployment Guide, which provides information about how 
to configure, install, start, and stop Framework components.

• Framework 8.0 Genesys Administrator Help, which provides instructions 
for configuring and provisioning contact center objects using Genesys 
Administrator.

• Framework 7.6 SIP Server Deployment Guide, which provides information 
about how to configure and install SIP Server.

• Genesys Technical Publications Glossary, which ships on the Genesys 
Documentation Library DVD and which provides a comprehensive list of 
the Genesys and CTI terminology and acronyms used in this document.

Release Notes and Product Advisories for this product, which are available on 
the Genesys Technical Support website at http://genesyslab.com/support.
Information about supported operating systems and third-party software is 
available on the Genesys Technical Support website in the following doc
• Genesys Supported Operating Systems and Databases 
• Genesys Supported Media Interfaces 
Genesys product documentation is available on the:
• Genesys Technical Support website at http://genesyslab.com/support.
• Genesys Documentation Library DVD, which you can order by e-mail 

from Genesys Order Management at orderman@genesyslab.com. 

Making Comments on This Document
If you especially like or dislike anything about this document, feel free to e-
mail your comments to Techpubs.webadmin@genesyslab.com. 
You can comment on what you regard as specific errors or omissions, and on 
the accuracy, organization, subject matter, or completeness of this document. 
Limit your comments to the information in this document only and to the way 
in which the information is presented. Speak to Genesys Technical Support if 
you have suggestions about the product itself.
When you send us comments, you grant Genesys a nonexclusive right to use or 
distribute your comments in any way it believes appropriate, without incurring 
any obligation to you.

http://genesyslab.com/support
http://genesyslab.com/support
mailto:orderman@genesyslab.com
mailto:techpubs.webadmin@genesyslab.com
http://genesyslab.com/support
http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=A9CB309AF4DEB8127C5640A3C32445A7&view=item
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Part

1 Planning
Part One of this Deployment Guide describes the architecture of the Genesys 
Voice Platform (GVP) and how to plan the deployment. This information 
appears in the following chapters:
• Chapter 1, “GVP Architecture,” on page 17
• Chapter 2, “Prerequisites and Planning,” on page 41
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Chapter

1 GVP Architecture
This chapter describes the primary components and basic architecture of 
Genesys Voice Platform (GVP) 8.0. It contains the following sections:

Overview, page 17
Features, page 19
GVP Components, page 21
Integration with Genesys Components, page 36
Web Server, page 38
Caching, page 38
Third-Party Software, page 39

Overview
Genesys Voice Platform (GVP) is a software suite that integrates a 
combination of call processing, reporting, management, and application 
servers with Voice over IP (VoIP) networks, to deliver web-driven dialog and 
call control services to callers.
GVP 8.0 provides Genesys customers with the ability to deliver interactive, 
media-centric applications to end users. Whereas GVP is commonly used in 
enterprise self-service environments using voice over telephone, many other 
applications—including those outside of the contact center—are possible.
The changes in the high-level architecture of GVP 8.0 are summarized here:
• User Interaction Layer—enhanced features, such as a Web Graphical User 

Interface (GUI) to ensure parity with previous versions of GVP and 
VoiceGenie (VG).

• SIP Server—interaction between GVP and Session Initiation Protocol 
(SIP) Server is significantly streamlined as SIP Server is the focal point for 
integration with third-party SIP devices.



18 Genesys Voice Platform 8.0

Chapter 1: GVP Architecture Overview

GVP supports Call Control Extensible Markup Language (CCXML) 1.0, Voice 
Extensible Markup Language (VoiceXML) 2.0, and VoiceXML 2.1. See the 
Open Standards listed in Table 1.
Application servers within a GVP deployment are required to store and deliver 
VoiceXML and CCXML applications. VoiceXML and CCXML documents 
can be generated dynamically using any number of web-based technologies, 
such as Active Server Pages (ASP) or Java Server Pages (JSP), or by using a 
complete application development and execution environment, such as 
Genesys Composer Voice. For more information about Composer Voice, see 
“Composer Voice” on page 35.
GVP supports Automatic Speech Recognition (ASR) and speech synthesis 
(Text-to-Speech [TTS]) as part of a VoiceXML dialog, through supported 
third-party ASR and TTS engines that use the Open Standards listed in 
Table 1.
Communication among GVP, ASR, and TTS engines occurs by using the 
Media Resource Control Protocol (MRCPv1 and MRCPv2), following the 
recommendation listed in Table 1. MRCP was originally developed by Cisco, 
Nuance, and SpeechWorks, and is now maintained by the Internet Engineering 
Task Force (IETF).

Table 1: Supported Open Standards

Feature Open Standard

VoiceXML 2.0 W3C standard Voice Extensible Markup Language 
(VoiceXML) Version 2.0, W3C Recommendation, 
16 March 2004

VoiceXML 2.1 W3C standard Voice Extensible Markup Language 
(VoiceXML) Version 2.1, W3C Recommendation, 
19 June 2007

CCXML 1.0 W3C Voice Browser Call Control: CCXML Version 1.0, 
W3C Working Draft, 29 June, 2005

Supported ASR 
Grammar 
Format—SRGS

W3C standard Speech Recognition Grammar 
Specification (SRGS) Version 1.0, W3C 
Recommendation, March 2004

Supported TTS 
Markup—SSML

W3C standard Speech Synthesis Markup Language 
(SSML) Version 1.0, W3C Recommendation 7 September 
2004

MRCPv1 Internet Engineering Task Forces (IETF) RFC 4463

MRCPv2 Internet Engineering Task Forces (IETF) RFC 4463
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GVP integrates with the Genesys Framework to deliver next-generation voice 
processing that meets advanced call-routing and voice self-service needs for an 
enterprise contact center.
The GVP application is different from traditional Interactive Voice Response 
(IVR) solutions. The GVP does not rely on proprietary hardware, and executes 
voice and call control applications that are created in nonproprietary coding 
languages—VoiceXML and CCXML. By using standards such as these, GVP 
separates the voice and call control applications from the call processing 
environment.
The GVP software resides on a server that contains the voice and call control 
browser that interprets VoiceXML and CCXML documents into call-
processing events. GVP also supports VoIP technology.
The GVP voice and call control applications reside on a separate web server. 
Access to these applications (IVR Profiles) are configured and managed 
through the Genesys Administrator. To complete the solution, a web server is 
added to the GVP deployment for hosting VoiceXML and CCXML 
applications.

Features
GVP provides a variety of features that support call handling for voice and call 
control applications through either Time Division Multiplexing (TDM) (by 
using a third-party gateway) or VoIP functionality. GVP also expands 
traditional IVR functionality with self-service and assisted-service capabilities 
that are tightly integrated with the Genesys product suite, and a flexible 
standards-based voice processing platform.
This section provides an overview of the following features:
• Core Telephony Features on page 19
• Advanced Features on page 20
• Voice Application Features on page 20
• Coding Language on page 20
• Developer Tools on page 21

Core Telephony Features
The following core telephony features are available:
• Call handling through SIP.
• Support for major PBX switches through the SIP Server.
• Support for blind and consultive IP call transfers triggered by SIP REFER. 

SIP REFER also triggers TDM/Public Switched Telephone Network (PSTN) 
network transfers when the media gateway supports this functionality.
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• Call Bridging with the inbound and outbound leg maintained (for the call 
duration) when GVP sits in front of the switch.

• Support for major media gateways.
• Media services including voice prompts, menus, and data (Dual-Tone 

Multi-Frequency [DTMF] or speech) collection.
• Acceptance and processing of information delivered with a call from the 

media gateway, including Automatic Number Identification (ANI), DNIS, 
and Calling Line Identification (CLID).

Advanced Features
The following advanced features are available:
• Automatic Speech Recognition (ASR)
• Text-to-Speech (TTS)
• Conferencing
• Intelligent call routing provided by Genesys Enterprise Routing Solution 

(ERS) and Network Routing Solution (NRS), when combined with other 
Genesys products

• Call parking, providing multi-site contact centers with the ability to enable 
self-service and call queuing on GVP, prior to transferring or bridging the 
call to an agent

• Graphical User Interface (GUI) for the development of VoiceXML 
applications using Composer Voice

• Real-time call monitoring and management, as well as historical reporting 
and analysis

• Web-based GUI for configuration of system features and voice 
applications, as well as diagnostics and other administrative functions

• Flexible deployment options

Voice Application Features
Voice applications reside on a web server that is accessed by the GVP 
VoiceXML interpreter on every call. GVP supports interactions with multiple 
web servers using standard Hypertext Transfer Protocol (HTTP). If voice 
applications reside on separate web servers, these web servers can be located 
on a web farm architecture in a local or remote network configuration.

Coding Language
Voice and call control applications written for GVP must be in standard 
VoiceXML and CCXML, respectively. GVP supports the open standards for 
these applications, listed in Table 1 on page 18. GVP also supports extensions 
to assist in the call-control requirements of a voice application.
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Developer Tools
Genesys Composer Voice is a voice application development tool that is used 
to develop VoiceXML and CCXML applications. Customers can use the 
Graphical User Interface (GUI) to build voice and call control applications 
using the Drag-and-Drop paradigm. 
For more information about Composer Voice, see “Composer Voice” on 
page 35.

GVP Components
GVP 8.0 provides a unified communication layer within the Genesys suite and 
offers a robust solution that incorporates all required call control—including 
Computer Telephony Integration (CTI)—and media-related functions.
Figure 1 depicts the GVP solution architecture and the communication 
channels.

Figure 1: Genesys Voice Platform Solution Architecture

The components described in this section are mandatory for all GVP 
configurations, with the exception of the Call Control Platform and Composer 
Voice.
The Call Control Platform is required only for configurations that use 
CCXML. Composer Voice is the preferred tool for customers who write their 
own applications, but you can use any tool you chose—using Composer Voice 
is optional.
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This section describes the following components:
• Resource Manager on page 22
• Media Control Platform on page 26
• Call Control Platform on page 30
• Reporting Server on page 33
• Composer Voice on page 35

Resource Manager
The Resource Manager controls access and routing to all resources in a 
GVP 8.0 deployment, including instances of the Media Control Platform and 
Call Control Platform. 
Application management is a key function of the Resource Manager. It is the 
first element to process requests for services and it interacts with the 
Configuration Server to determine the application, resource, and service profile 
required to deliver the service. It then pushes the profile to a component that 
can deliver the service.
This section provides an overview of the following topics:
• SIP Proxy on page 22
• Functions on page 22
• Interfaces on page 25

SIP Proxy

The Resource Manager resides between all SIP resources within the GVP 
system architecture. It acts as a proxy for SIP traffic between any two SIP 
components.
Acting as a SIP proxy, the Resource Manager is the interface to a collection of 
media processing resources, such as the Media Control Platform, the Call 
Control Platform, audio and video conferencing, and other resources. SIP 
devices and applications can then make use of media-centric services through 
the proxy, without having to know the actual location of these resources or 
how to manage various routing decisions.
The SIP proxy services provided by the Resource Manager are used not only 
by clients such as media gateways or soft switches, but can also be used by 
internal media resources to coordinate interactions with one another.

Functions

Resource Manager performs and manages the following functions, described 
briefly in this section:
• Resource Management on page 23
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• Session Management on page 23
• Application, Tenancy, and Service Parameter Selection on page 24
• Service Parameter Modification on page 24
• Policy Enforcement on page 24
• Call Data Reporting on page 25
• Conference Service on page 25

Resource Management

SIP resources are managed and monitored by the Resource Manager to 
maintain a current status of the resources within a GVP deployment. Load 
balancing and high availability are provided for each resource type, as the 
work load is evenly distributed among resources of the same type. These 
processes ensure that new, incoming services are not interrupted when a 
resource is unavailable.

High Availability Two aspects of high availability exist within the Resource Manager:
• If an instance of a call processing component crashes—for example, an 

instance of the Media Control Platform or Call Control Platform—other 
components can still access the Media Control Platform service because 
the Resource Manager can load balance future requests to the remaining 
active Media Control Platform instances.

• The Resource Manager itself is highly available as it can run as a warm 
active/standby pair with a common virtual IP by using Windows Network 
Load Balancing (NLB).

Multiple clusters of Resource Manager instances that operate largely 
independently of one another, can be deployed to support large scale 
deployments, such as those that involve multiple sites. Each Resource 
Manager cluster manages its own pool of resources.
For more information about Windows NLB, see Appendix B on page 137.

Registration The Resource Manager acts as a Registrar for GVP resources, but accepts 
registration only from those resources that are already configured in the 
Configuration database. Registration occurs dynamically, therefore transparent 
relocation of GVP call processing components is supported.

Session Management

Two logical functions are combined in Session Management:
1. Physical resource management—used to monitor the status of various 

resources and to route to other resources that offer a particular set of 
capabilities or services.

2. Logical service management—used to apply high-level application and 
business logic to select the service that is delivered and the parameters that 
are applied, as opposed to specifying a resource to fulfill the service.
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In this way, logical call sessions, individual calls within a logical session, and 
the lifetime and coordination of call legs within a call session are handled by 
Session Management.

Application, Tenancy, and Service Parameter Selection

When a call session arrives at the Resource Manager, it is mapped to a tenant 
or application, and a service is selected for the request.

Application
Selection

When a request comes into the Resource Manager, it must choose an 
application to execute. There are various ways that it decides, however the two 
most common methods used by the GVP are:
• Application specified by DNIS—occurs when the Dialing Number 

Identification Service (DNIS) is used by the GVP to identify which voice 
application to run. In this scenario, the incoming call corresponds directly 
to the DNIS.

• Application specified as treatment within a call—occurs when another 
component (for example, Computer Telephony Integration [CTI]) acts as a 
master and executes a number of slave applications on the GVP. When a 
voice service is required as part of a call flow, the voice application 
invokes a treatment on the GVP. In this scenario, the service is invoked as 
part of the master call flow executed by the master voice application.

Tenancy Selection Tenancy selection occurs when a platform operator segregates its services to 
identify applications, enforce policy, and specify an application or service 
parameters in a multi-tiered manner.
When Resource Manager receives an request, it identifies which application to 
execute and the tenant for which it is intended. The policy enforcement, 
application and service parameters are determined by the tenant that is 
associated with the request.

Note: GVP 8.0 supports single-tenancy only.

Service Selection When Resource Manager receives a new SIP session, it attempts to identify the 
type of service and service prerequisites for which the session is intended.

Service Parameter
Selection

Each type of service within an application is configured with a set of service 
parameters that is forwarded to the application and affects the way it is 
executed. For example, Resource Manager can allow the platform operator to 
configure the default languages for the VoiceXML services for voice 
applications.

Service Parameter Modification

After an application and service type is identified, a request is forwarded to a 
resource that can handle the mapped service. The Resource Manager can attach 
additional information to the request before forwarding it. A platform operator 
configures the information on a per-service/per-application basis.
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Note: Definitions of the service parameters that are required for a service 
within an application are specific to the component that is providing 
the service. Resource Manager merely provides the framework within 
which an application defines the parameters that influence the way an 
application is executed.

Policy Enforcement

Resource Manager enforces policies by imposing them on an application to 
determine whether or not to accept a SIP session. If the session is accepted, a 
resource is located to handle it. The Resource Manager also enforces policies 
related to how an application uses a resource.

Call Data Reporting

When data collection and logging events occur, Resource Manager sends these 
log events to the Reporting Server.

Conference Service

Requests for conference services are not handled in the same manner as 
requests for other services. The Resource Manager must route requests for a 
particular conference ID to the same conference resource—even if it is from a 
different Resource Manager session. For service types other than conferencing, 
there is no special correlation between requests from different Resource 
Manager sessions.

Interfaces

The Resource Manager interacts with other components by using three main 
interfaces; a SIP interface for call handling, the Genesys Management 
Framework interface for retrieving configuration and provisioning 
information, and a Reporting Server interface for reporting events related to 
call processing.
The Resource Manager interfaces are described in Table 2.
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Media Control Platform
The Media Control Platform is the core component of the GVP, because it 
executes the actual voice applications in the solution. In addition, it is used by 
other communication layer components, like SIP Server, to provide broader 
customer service scenarios, such as agent interactions, and many other 
functions.
This section provides an overview of the following topics:
• Services on page 27
• Registration on page 27
• Functions on page 28
• Interpreters on page 28
• Interfaces on page 28

Table 2: Resource Manager Interfaces

Interface Description

SIP Used by GVP components to communicate with one another, and by 
external SIP-based network elements that require the use of GVP 
components. The SIP interface performs a critical role in the GVP 
architecture.
Used by GVP components to access the services offered by other 
components without knowing the location or status of the resource fulfilling 
the request.
Used by external components to access the services offered by the GVP 
components without knowing the topology or other details of the resource 
fulfilling the request, so the interaction is simplified

Management Framework Used by the Resource Manager to obtain configuration information for the 
SIP resources that it manages by consulting the Management Framework. 
The Resource Manager must be aware of these SIP resources and the 
services offered by each of them.

Reporting Server Used to integrate with the Reporting Server to access the reporting 
processes. When a new Resource Manager session or a SIP call is created 
or destroyed, the Resource Manager logs an event through the Reporting 
Server interface.

Simple Network 
Management Protocol 
(SNMP)

Used by the Genesys SNMP Master Agent to retrieve status information 
about the GVP component.
Used by Resource Manager to send traps to notify the Genesys SNMP 
Master Agent about error conditions in the component.
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Services

Media Control Platform services are defined by applications that are executed 
when a SIP session is established between the Media Control Platform and the 
service user. The Media Control Platform can host various application 
execution environments and use multiple implementations of a particular 
language. The Media Control Platform is most often used to deploy dialog-
based services that are built using languages like VoiceXML.
The Media Control Platform supports two other predefined services; 
announcements and conferencing. In conjunction with an underlying media-
processing resource, the Media Control Platform can provide extended 
versions of all services defined in NETANN—for example, announcements 
with TTS.

Note: NETANN defines a number of extensions to SIP, that allow a client to 
request execution of particular classes of applications, including simple 
announcements, conferences, and dialogs. NETANN is defined in RFC 
4240. Genesys Voice Platform supports only conference service and 
dialogs.

Service Delivery

The Media Control Platform controls overall application execution, but the 
applications rely heavily on access to media processing resources. Third-party 
ASR and TTS services are delivered by one or more underlying media 
processing resources (such as media servers, speech recognition servers, or 
speech synthesis servers).
These resources handle Real Time Protocol (RTP) packets in three ways:
1. By using direct or indirect RTP streams to interact with the service user
2. By processing or interpreting RTP packets received from the service user
3. By generating RTP packets for transmission to the service user
Interaction with the media processing resources occurs by various methods 
that include the RFC 4240 standard and the Media Resource Control Protocol 
version 1 (MRCPv1) and MRCPv2.

Registration

The Resource Manager detects instances of the Media Control Platform 
through configuration information retrieved from the Configuration 
Database—the Media Control Platform does not register with the Resource 
Manager at start up. To determine whether the Media Control Platform is alive, 
the Resource Manager sends SIP OPTIONS messages to the Media Control 
Platform periodically; the Media Control Platform responds with 200 OK.
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Functions

The Media Control Platform manages the following functions:
• Initiates outgoing calls
• Handles network-initiated call disconnections
• Performs application-initiated calls
• Supports VoiceXML applications
• Plays audio, video, and TTS prompts
• Streams TTS, audio, and video
• Records utterance data
• Performs ASR and DTMF input handling (barge-in or non-barge-in)
• Streams audio data to an ASR server for speech recognition
• Transfers calls
• Conferences calls
• Logs data and produces metrics
• Transcodes from one codec to another when bridging calls

Interpreters

The new Next Generation Interpreter (NGI) is the VoiceXML interpreter 
within the Media Control Platform. The interpreter is a library loaded by the 
Call Manager application. The NGI and Call Manager interact through the Call 
Manager API (CMAPI).
To enhance performance, especially for those applications that have large, 
static pages, the NGI supports caching documents based on content.
GVP accepts and initiates calls that invoke a VoiceXML dialog that is 
processed by the NGI and media operations that are handled by the Media 
Control Platform. The NGI interprets VoiceXML applications to determine the 
interactions that need to occur for each caller.

Interfaces

The GVP components interact with the NGI through the three interfaces that 
are described in Table 7 on page 35.
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:

Note: See “Squid Caching Proxy” on page 39 for more information about the 
on-board caching proxy.

The Media Control Platform interacts with other GVP components through six 
interfaces that are described in Table 4.

Table 3: NGI Interfaces

Interfaces Description

Debugger Used to communicates with the debug client GUI through standard TCP/IP, 
employing an XML document as the payload. This is a new external 
interface.
Used by Composer Voice to provide an integrated VoiceXML debugging 
environment.

Reporting Server Used to deliver log messages of type metric to the reporting infrastructure 
of the Media Control Platform—the NGI does not interact with the 
Reporting Server directly.

Fetching Module/HTTP Used to retrieve VoiceXML documents, scripts, grammars, and media 
content specified by a Universal Resource Locator (URL), such as, file:\\, 
http:\\, or https:\\. The Fetching Module maintains a high-performance 
shared memory cache and interfaces with the on-board caching proxy.

Table 4: Media Control Platform Interfaces

Interface Description

SIP Used by GVP components to communicate with one another, and by 
external SIP-based network elements requiring the use of GVP 
components. The SIP interface performs a critical role in the GVP 
architecture.
Used by GVP components to access the services offered by other 
components without knowing the location or status of the resource fulfilling 
the request.
Used by external components to access the services offered by the GVP 
components without knowing the topology or other details of the resource 
fulfilling the request, so the interaction is simplified

Management Framework Used by the Media Control Platform to obtain the configuration 
information it needs to communicate with the SIP proxy (Resource 
Manager). The Media Control Platform must be aware of the SIP proxy 
resources and the services offered by each of them.
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Call Control Platform
The Call Control Platform supports the execution of CCXML 1.0 applications 
in SIP-based environments. Therefore the Call Control Platform services are 
defined by applications written in CCXML.
CCXML is not a media/dialog language like VoiceXML, so it does not provide 
any dialog resources on its own. It only supports moving calls around and 
connecting them to dialog resources.
The Call Control Platform retrieves configuration data from the Management 
Framework.
This section provides an overview of the following topics:
• Registration on page 30
• Functions on page 31
• Interfaces on page 32
• Session Data on page 32

Registration

The Resource Manager detects instances of the Call Control Platform through 
configuration information retrieved from the Management Framework—the 
Call Control Platform does not register with the Resource Manager at startup. 
To determine whether the Call Control Platform is alive, the Resource 

NETANN Service Used to expose the services offered by the Media Control Platform in 
accordance with the RFC 3261 and RFC 4240 (NETANN) standards and 
the Internet-Draft draft-ietf-mediactrl-vxml The interface is accessed 
through the Resource Manager, but can be accessed directly in a standalone 
configuration.

Reporting Server Used to integrate with the Reporting Server to access the reporting 
processes. When a new VoiceXML session or a SIP call is created or 
destroyed, the Media Control Platform logs an event through Reporting 
Server interface.

Speech Server Used to access speech resources, such as Automatic Speech Recognition 
(ASR) and Text-to-Speech (TTS). The Media Control Platform interacts 
directly with ASR and TTS engines using MRCPv1 and MRCPv2.

Simple Network 
Management Protocol 
(SNMP)

Used by the Genesys SNMP Master Agent to retrieve status information 
about the GVP component.
Used by Media Control Platform to send traps to notify the Genesys SNMP 
Master Agent about error conditions in the component.

Table 4: Media Control Platform Interfaces (Continued) 

Interface Description
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Manager sends SIP OPTIONS messages to the Call Control Platform 
periodically; the Call Control Platform responds with 200 OK.

Functions

The Call Control Platform conforms to the W3C CCXML standard for call 
control to accept, reject, or redirect calls. 
The Call Control Platform performs the following functions:
• Initiates Conferencing.
• Initiates a VoiceXML dialog on an Media Control Platform through the 

Resource Manager.
• Creates an outbound call through an IP/PSTN gateway.
• Applies implicit transcoding by using a media server.
• Starts a new CCXML session (request from web server directly).
To receive requests from and send requests to the GVP components, Call 
Control Platform acts like a SIP Back to Back User Agent (B2BUA). The Call 
Control Platform achieves call control by sending a request to the Resource 
Manager to acquire access to the resource. When the request is received, the 
Resource Manager finds the appropriate resource—for example, the Media 
Control Platform—and forwards the request. Call Control Platform uses the 
NETANN and the draft-burke SIP messaging standard for requests for service.
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Interfaces

The Call Control Platform interfaces are described in Table 5.

Session Data

The Call Control Platform maintains the current, peak, and total count data 
and exposes it to a GUI for monitoring. Data is captured for the following 
objects:
• CCXML connections
• CCXML dialogs
• CCXML conferences
• Conference participants

Table 5: Call Control Platform Interfaces

Interface Description

SIP Used by GVP components to communicate with one another, and by 
external SIP-based network elements requiring the use of GVP 
components. The SIP interface performs a critical role in the GVP 
architecture.
Used by GVP components to access the services offered by other 
components without knowing the location or status of the resource 
fulfilling the request.
Used by external components to access the services offered by the GVP 
components without knowing the topology or other details of the 
resource fulfilling the request, so the interaction is simplified.

Management Framework Used by the Call Control Platform to obtain the configuration 
information it needs to communicate with the SIP proxy—the Resource 
Manager or bridging server. The Call Control Platform must be aware of 
the SIP proxy resources and the services offered by each of them.

Reporting Server Used to integrate with the Reporting Server to access the reporting 
processes. When a new CCXML session or a SIP call is created or 
destroyed, the Call Control Platform logs an event through Reporting 
Server interface.

HTTP Used by external entities to initiate a new CCXML session by using 
HTTP POST through the createsession event I/O processor.

Simple Network 
Management Protocol 
(SNMP)

Used by the Genesys SNMP Master Agent to retrieve status information 
about the GVP component.
Used by Call Control Platform to send traps to notify the Genesys SNMP 
Master Agent about error conditions in the component.
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• Bridging server participants
• CCXML sessions

Reporting Server
The Reporting Server component of the GVP solution provides a 
comprehensive view of the calls serviced by a GVP deployment. The 
Reporting Server receives data from the Media Control Platform for 
VoiceXML applications, from the Call Control Platform for CCXML 
applications, and from other components involved in servicing a call, such as 
the Resource Manager.
Two main components exist within the Reporting Server:
• The Logging/Reporting Client that contains an interface that routes the 

logs emitted by the GVP components to one or more data collection sinks.
• The Reporting Server that stores and summarizes data and statistics 

submitted by the Reporting Clients to provide hourly, daily, weekly, and 
monthly reports.

The Reporting Server provides near-real-time reporting—that is, information 
collected is submitted as soon as it is available or committed. For example, 
when data is conditionally logged the data is not committed until the end of the 
call; it is retained, depending on the final outcome of the call.
The Reporting Server is integrated with the Management Framework to ensure 
that its configuration and provisioning are consistent with all other Genesys 
components.
This section provides an overview of the following topics:
• Functions on page 33
• Interfaces on page 34

Functions

The Reporting Server ensures accurate and up-to-date reporting of information 
and statistics related to the call, such as:
• Near-real-time data collection and processing
• Data reliability—accumulated data is not lost if the Reporting Server or 

other components are off line for a period of time.
• Open data access interfaces (through Reporting Web Services) that allow 

multiple user interfaces, including third-party interfaces to access call 
related data. Call-related data is obtained without accessing the data store 
directly. 

• An interface that caters to various classes of users depending on their 
reporting needs
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• XML reports that correspond to report requests made through Reporting 
Web Services.

In addition, Reporting Server generates partial or full background call 
recordings, collected utterances, and third-party logs, such as those generated 
by speech engines. Because a call affects multiple components, a common 
logging identifier is propagated so that logged information is correlated across 
multiple components.

Interfaces

Seven interfaces exist within the Reporting Server client/server infrastructure. 
These external components are briefly described in Table 6:

Table 7 on page 35 indicates the components that access the Reporting Server 
interfaces.

Table 6: Reporting Server Interfaces

Interface Description

EMS Logging API Used by each GVP component to emit component logging events 
and call related events (if applicable).

CDR Service API Used to submit and update component Call Detail Records (CDR).

Operational Reporting API Used to submit call peak, call arrival, and length distribution 
information from the call processing components.

MF Logging API Used to collect the configured events emitted by the call processing 
components and delivered to the Management Framework through 
this interface.

Platform SDK Used by Reporting Server to connect to the Management Framework 
configuration, logging, and Local Control Agent (LCA).

Reporting Web Service Used by HTTP web services to return XML content that conforms to 
well-defined schema.
Used by external components, such as Genesys Administrator, to 
produce Graphical User Interfaces (GUI).

Simple Network Management 
Protocol (SNMP)

Used by the Genesys SNMP Master Agent to retrieve status 
information about the GVP component.
Used by Reporting Server to send traps to notify the Genesys SNMP 
Master Agent about error conditions in the component.
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Composer Voice
The Composer Voice development environment is an integrated environment 
which simplifies the creation of voice applications. Developers use the 
Composer Voice authoring tool to build voice applications from a visual call 
flow editor or a rich XML editor. Applications are compiled and deployed 
directly to a web application server and are then fetched and executed by the 
voice platform.
Composer Voice includes a run-time tool that debugs VoiceXML applications 
in real time, while the developer performs testing by using a SIP phone. 

Note: The run-time debugger and the code created with the tool work only 
with the Next Generation Interpreter (NGI).

Functions

Composer Voice performs the following functions:
• Create voice applications using a visual call flow editor.
• Generate VoiceXML code from the visual call flow.
• Edit and write VoiceXML, CCXML, and GRXML (speech recognition 

grammars) code.
• Test and debug VoiceXML applications.

Table 7: Component interaction with Reporting Server

Interface Interacts with:

RM MCP CCP RS MF Composer
Voice

Logging API

CDR Service API

Operational Reporting API

MF Logging API 

Platform SDK

Reporting Web Service

Legacy VAR Service
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• Provide project management.
• Obtain version history and team support.

Note: Composer Voice supports testing and debugging VoiceXML 
applications written by using third-party development tools.

Integration with Genesys Components
The GVP components integrate with the other Genesys Suite components to 
extend the features and functionality of the voice platform, thereby increasing 
the flexibility of your deployment. 
This section describes two Genesys Suite components, that are required to 
create an overall solution:
• SIP Server on page 36
• User Interaction Layer on page 37

SIP Server
SIP Server is a T-Server for IP environments in which Genesys T-Lib 
applications, such as Universal Routing Server (URS), Outbound, and Agent 
Desktop, deliver services in SIP environments. It is a critical integration point 
for GVP components that interact with network and T-Lib applications.

Interfaces

Unlike other T-Servers, SIP Server operates in environments where there are 
no switches present. It supports direct interfaces and connectivity to IP agents, 
voice platforms, gateways, soft switches, and other elements that are used to 
establish inbound and outbound communication sessions with customers.
SIP Server acts as a SIP Back-to-Back User Agent (B2BUA) and controls the 
flow of SIP requests and responses between SIP endpoints, performing the 
switching functions that are normally performed by the PBX or ACD.

Routing

SIP Server can be used in conjunction with an IP PBX or ACD. Used in this 
way, it controls the routing and transformation of requests, but does not act as a 
registrar with which agents communicate. This type of control is normally 
provided by a CTI link.
For more information about SIP Server and integration with GVP, see the 
Voice Platform Solution 8.0 Integration Guide.
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User Interaction Layer
The User Interaction Layer acts as a manager and administrator for all of the 
GVP components. It provides an interface to the configuration and 
management layers and to other Genesys solutions.
Genesys Administrator is the GUI that is used to manage all of the Genesys 
products, including GVP, with a single user interface. For a summary of 
Genesys Administrator, see “Genesys Administrator”.
In GVP 8.0, the User Interaction Layer appears as a unified web-based 
interface.

Functions

The following functions exist within the User Interaction Layer:
• Configuration
• Provisioning
• Management operations (starting or stopping applications)
• Current status monitoring
• Installation
• Deployment
• Data collection and logging
• Data management
In addition, the User Interaction Layer supports SNMP integration and third-
party management systems.

Genesys Administrator

Genesys Administrator is the web-based GUI used to deploy, provision, and 
monitor GVP components. You can log in to Genesys Administrator by typing 
the URL in a web browser—for example, http://<Genesys Administrator 
host>/wcm/. 
Genesys Administrator retrieves information about GVP applications and 
components from the Configuration database because Genesys Administrator 
is integrated with the Management Framework. Therefore, you can use 
Genesys Administrator as an interface to create, modify, delete, and save GVP 
information.
For more information about the Genesys Administrator, see the Framework 8.0 
Genesys Administrator Help.
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Web Server
Communication between the web server and GVP is analogous to the desktop 
web browser model. In a standard web-based application, desktop browsers 
make requests to an application server to provide HTML to render the web-
based application. The browser renders a web page, and establishes links to 
other pages on the Web. When you click a link, the browser issues a request to 
the designated URL, which results in the retrieval and rendering of another 
web page. When the page or its contents change, the next request from any 
browser retrieves the changed page.
Requests and information exchanged on GVP are handled in a similar fashion, 
but the markup languages are CCXML and VoiceXML instead of HTML. The 
GVP has both CCXML-enabled and VoiceXML-enabled web clients that 
retrieve pages from web servers. Call control and voice applications are 
generally developed as Active Server Pages (ASP) or Java Server Pages (JSP) 
that render and deliver instructions in CCXML or VoiceXML. The Call 
Control Platform and Media Control Platform interpreters parse the CCXML 
or VoiceXML to affect:
• Call handling (answering, bridging, and disconnecting calls).
• Media management (plays greetings, prompts, and messages using cached 

voice files and text-to-speech).
• Caller input (collects touch-tone digits and performs speech recognition).
The Media Control Platform and Call Control Platform enable VoiceXML and 
CCXML applications to drive an interaction with a caller in the same way that 
the desktop web browser would interact with an application server to render a 
screen, and to react to keyboard or mouse input. As with the desktop browser, 
any changes to the call control or voice application on the application server 
becomes effective the next time a page is requested.

Caching
The VoiceXML and CCXML interpreters, like visual web browsers, can use 
caching to improve performance in fetching documents and other resources; 
audio and video recordings (which can be quite large) are as common to 
VoiceXML and CCXML documents as images are to HTML pages. In a visual 
web browser, it is common to include end user controls to update or refresh 
content that is perceived to be stale. This is not the case for the VoiceXML and 
CCXML interpreters, because they lack equivalent end user controls. 
Therefore, enforcement of cache refresh is at the discretion of the document 
through the appropriate use of the maxage and maxstale header attributes in the 
HTTP request to the application server.
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GVP Caching

GVP can perform the caching function itself, or, you can add another server—a 
caching appliance, or a web proxy server.
External caching servers can be beneficial. For example, if you have a site with 
ten GVP servers and an audio file expires, each server must go fetch a new 
copy of the audio file. If there is an external cache server, fetching a new copy 
of the audio file occurs only once. Also, the external cache servers typically 
have very robust cache management tools to purge and refresh content.
GVP components (the Media Control Platform and Call Control Platform) use 
the Fetching Module to fetch documents and perform caching. The Fetching 
Module maintains a high performance shared memory cache, and interfaces with 
the on-board Squid Caching Proxy. See “Squid Caching Proxy” for more 
information about how GVP performs caching.

Third-Party Software
The following section describes the third-party software used in conjunction 
with GVP.

Automatic Speech Recognition
GVP uses MRCP speech-recognition technology to incorporate Automatic 
Speech Recognition (ASR) for use in voice applications. The GVP ASR 
architecture is economically scalable as the volume of the calls requiring 
speech recognition rises, and new voice applications are acquired.

Text-to-Speech
GVP uses MRCP speech synthesis technology to incorporate Text-to-Speech 
(TTS) for use in voice applications.

Squid Caching Proxy
The third-party Squid software acts as a caching proxy for the Fetching 
Module. Like any other caching mechanism, the Squid Proxy caches 
frequently used files so that fetching a copy of a file need only occur once; 
subsequently the file is retrieved from the cache.
The Squid software is included on the GVP CD and is installed prior to 
installing the Fetching Module.
For information about how to install Squid Caching Proxy and the Fetching 
Module, see Installing the Squid caching proxy, page 70 and Installing the 
Fetching Module, page 71.
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Reporting Databases and Schemas
GVP Reporting Server employs the Structured Query Language (SQL) to 
interacts with both Microsoft SQL and Oracle DB servers. These Relational 
Database Management Systems (RDBMS) retrieve and manage data in the 
relational database, create and modify the database schemas, and provide the 
control management for database object access. 

Java Application Server

The Jakarta Tomcat Java-based application server, which runs on the Sun JDK 
6 platform is a prerequisite for the GVP Reporting Server host. It is installed to 
implement Java Servlet and JavaServer Page (JSP) specifications that enable 
Java code to run in cooperation with a web server. 
For information about the GVP supported versions of Microsoft SQL Server, 
Oracle DB Server, Jakarta Tomcat, and Sun JDK 6, see “Prerequisites” on 
page 42.
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2 Prerequisites and Planning
This chapter describes the prerequisites and planning considerations for 
deploying Genesys Voice Platform (GVP) 8.0. It includes information about 
the required software.
This chapter contains the following sections:

GVP Installation CDs, page 41
Prerequisites, page 42
Antivirus Software, page 44
Host Setup, page 45
Voice Platform Solution, page 45

GVP Installation CDs
The Genesys Voice Platform (GVP) components are shipped on one CD. The 
CD includes these components:
• Resource Manager (RM)
• Media Control Platform (MCP)
• Call Control Platform (CCP)
• Reporting Server (RS)
• Fetching Module (FM)
• Squid Caching Proxy
• Management Information Bases (MIB)
The Genesys Composer Voice installation software ships on a separate CD.
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Note: GVP is installed, provisioned, and managed in Genesys Administrator. 
Ensure that you have Genesys Administrator installed as part of your 
deployment. For information about Genesys Administrator, see the 
Framework 8.0 Deployment Guide.

Prerequisites
Table 8 summarizes the software requirements for GVP 8.0 deployments on 
Windows hosts.

Note: Genesys recommends that you review “Host Setup” on page 45 and 
“Deployment Task Summary” on page 51 before you install any 
software.

Table 8: Software Requirements

Category Requirements and Comments

Operating System (OS) on GVP servers
(Mandatory)

For Genesys Voice 
Platform 8.0:

• Microsoft Windows 2003 Server, SP2, 32-bit

Operating System supporting components
(Mandatory)

Database server • Microsoft SQL Server 2005 SP2, with XA support or Oracle 10 g 
Database Server

• Jakarta Tomcat 6.0.16 and Sun JDK 6 Update 5 or later
Only required on GVP servers with Reporting Server installed.
You can download the SQL Server software from the Microsoft website.
You can download the Oracle database software from the Oracle 
website.
You can download the Jakarta Tomcat application server and Sun JDK 
platform software from the Sun Microsystems/Apache website.
The acquisition of licenses for this software is the responsibility of the 
customer.
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Microsoft Internet 
Information Server (IIS) 6.0 
components

• Common Files
• Internet Information Services Manager Snap-In for Microsoft 

Management Console
• World Wide Web Server 
Install these component from the Windows 2003 CD through 
Add/Remove Programs or visit the Microsoft web site to download these 
components.

Management and 
Monitoring Tools

• Genesys Simple Network Management Protocol (SNMP) Master 
Agent

• SNMP Network Management Software (NMS) 
(Optional)

The Genesys SNMP Master Agent is installed on the same host(s) as the 
GVP Resource Manager, Media Control Platform, Call Control 
Platform, and Fetching Module components.
Obtain the Genesys SNMP Master Agent software from the Genesys 
Management Framework Installation CD. See Chapter 3, “Deployment 
Task Summary,” on page 51.
Use any type of SNMP NMS—for example, HP OpenView.

Specific services and 
settings

You must configure certain specific services and settings on each host 
before you install GVP
For more information, see “Windows Services and Settings” on page 55.

 Web Browser (for 
Administration)
(Mandatory)

• Microsoft Internet Explorer (IE) 6.0 SP1 or 7.0
Used only from the Administrator’s desktop.

Table 8: Software Requirements (Continued) 

Category Requirements and Comments
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Note: Genesys highly recommends that the ASR and TTS servers are 
installed and operational before you install the Genesys Voice Platform

Antivirus Software
Antivirus software can potentially impact system performance and may affect 
call response time. In an ideal deployment, antivirus software would be 
disabled in GVP systems. However, Genesys understands the need to have 
antivirus protection on servers. Genesys therefore recommends, at a minimum, 
that you exclude the GVP directory from virus scanning, and schedule system 
scans to occur at times when traffic is low.
Also, be aware that antivirus software may interfere with the installation of 
GVP during initial deployment. Make sure that the server is not running 
antivirus software, or any other third-party software, during installation.

Automatic Speech 
Recognition (ASR)
(Optional).

Genesys has validated the following third-party ASR software:
• Nuance SpeechWorks Media Server (SWMS) 3.1 with Nuance 

OpenSpeech Recognizer (OSR) 3.0
• Nuance 5.0 Speech Server with Nuance Recognizer 9.0
It is your responsibility to obtain the software and the appropriate 
licenses. MRCPv1 and MRCPv2 are supported
For additional speech information, see the Genesys 7 Supported Media 
Interfaces Reference Manual.

Text-to-Speech (TTS)
(Optional)

Genesys has validated the following third-party software:
• Nuance SpeechWorks Media Server (SWMS) 3.1 with Nuance 

RealSpeak TTS 4.0
• Nuance 5.0 Speech Server with Nuance RealSpeak 4.5
• IBM WebSphere Voice Server (WVS) 5.1.3 TTS or higher, with IBM 

Text-to-Speech Connector
It is your responsibility to obtain the software and the appropriate 
licenses. MRCPv1 and MRCPv2 are supported.
For additional speech information, see the Genesys 7 Supported Media 
Interfaces Reference Manual.

Table 8: Software Requirements (Continued) 

Category Requirements and Comments
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Host Setup
GVP provides some flexibility in combining various components on one host; 
however, the following restrictions apply:
• The Fetching Module and the Squid Caching Proxy are required on 

computers hosting the Media Control Platform and Call Control Platform 
components.

• Install GVP components on a host separate from the Genesys 
Administrator web server host. Installing some GVP components can stop 
the web server momentarily. If the web server does not run continuously, 
the Genesys Administrator Deployment tool indicates the deployment is 
incomplete.

Voice Platform Solution
This section describes the required and optional elements for a successful 
deployment of a Voice Platform Solution (VPS) and the elements that are 
optional.

Voice Platform Solution and Dependencies

The following is an overview of a VPS and the associated dependencies:
• A centralized instance of Genesys Management Framework that includes 

the following components:
Configuration Database
Log DB Server

MS SQL Server
Oracle 10 g DB Server

Mult-tenant Configuration Server
Genesys Administrator
Solution Control Server
Solution Control Interface
Message Server 
Local Control Agent—required on all GVP 8.0 hosts
Optional: Genesys SNMP Master Agent on all GVP 8.0 hosts

• SIP Server
• VP Resource Manager

Mandatory component—one per deployment
Can deploy as a pair in Active/Standby for High Availability (HA)
Prerequisite: Local Control Agent
Optional: SNMP Master Agent
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• VP Fetching Module:
Mandatory component—required on all Media Control Platform and 
Call Control Platform machines
Prerequisite: VP Squid Caching Proxy
Prerequisite: Local Control Agent
Optional: SNMP Master Agent

• VP Media Control Platform: 
Mandatory component—one or more per deployment
Prerequisite: VP Fetching ModuleVP
Prerequisite: Local Control Agent
Optional: SNMP Master Agent

• VP Call Control Platform:
Optional component—one or more per deployment
Prerequisite: VP Fetching Module
Prerequisite: Local Control Agent
Optional: SNMP Master Agent

• VP Reporting Server:
Mandatory component—one per deployment
Prerequisite: Local Control Agent
Prerequisite: Database Server (MS SQL Server 2005 or Oracle 10 g)
Prerequisite: Jakarta Tomcat JDK 6, Update 5, and Apache Tomcat 
6.0.16.
Optional: SNMP Master Agent

VPS Components—Minimum Deployment

At a minimum, the required elements to deploy a VPS are:
• Management Framework components
• Genesys Administrator
• SIP Server
• GVP components

1 Resource Manager
1 Reporting Server
1 Media Control Platform 

Fetching Module
Squid Caching Proxy
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Optional Components

The following components are optional:
• One additional VP Resource Manager (for High Availability in 

Active/Standby)
• Multiple VP Media Control Platforms with VP Fetching Module and VP 

Squid (depends on sizing).
• One, or multiple VP Call Control Platforms with VP Fetching Module and 

VP Squid (depends on sizing)
• The SNMP Master Agent (See “Voice Platform Solution and 

Dependencies” on page 45.
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2 Installation
Part Two of this Deployment Guide describes the installation of Genesys Voice 
Platform (GVP) on the Windows operating system using the Genesys 
Administrator. This information appears in the following chapters:
• Chapter 3, “Deployment Task Summary,” on page 51
• Chapter 4, “Preparing Your Environment,” on page 55
• Chapter 5, “Installing GVP Manually,” on page 59
• Chapter 6, “Post-Installation Activities on the GVP Hosts,” on page 81
• Chapter 7, “Maintaining GVP,” on page 119
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3 Deployment Task Summary
This chapter provides a summary of various deployment tasks for a Genesys 
Voice Platform (GVP) manual installation, and provides links to detailed 
information about the required tasks.
It contains the following section:

Installing GVP Manually, page 51

Installing GVP Manually
Table 9 summarizes the steps to install GVP manually in a Windows 
environment, using Genesys Administrator.
For information about how to install GVP manually, see Chapter 5 on page 59.

Table 9: Task Summary—Installing GVP Manually

Objective Related Procedures and Actions

Plan the deployment For specific restrictions and recommendations to consider, see 
“Host Setup” on page 45.

Prepare your environment 1. Install the latest Installation Package (IP) for the Genesys 
Management Framework; ensure that it is fully 
operational and running.

You must install Multi-tenant Configuration Server. This 
ensures that the GVP Resource Manager has access to the 
Environment tenant. (which is not available with the Single 
tenant Configuration Server).
See Framework 8.0 Deployment Guide.
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Prepare your environment (continued) 2. Install Genesys Administrator and ensure that it is fully 
operational.

See Framework 8.0 Deployment Guide.

3. Install and configure the Genesys SNMP Master Agent.
The SNMP Master Agent must be installed on the same 
host(s) as the Resource Manager, Media Control Platform, 
Call Control Platform, and Fetching Module components.
See Framework 8.0 Deployment Guide.

4. Obtain server and database information.
During installation, you will need to provide information such 
as fully qualified domain names (FQDNs) of GVP and third-
party servers, database names, and database user names and 
passwords.

5. Install prerequisites on Reporting Server host. For more 
information about this software, go to the vendor’s 
website.

Jakarta Tomcat 6.0.16 Application server, and the Sun JDK 6 
Update 5 platform are required on the Reporting Server host 
before the Reporting Server Application object is installed. 
For information about prerequisite software, see 
“Prerequisites” on page 42.

6. Install and configure third-party hardware and software. 
For more information about this software, see your 
MRCP vendor’s documentation.

If you are using Automatic Speech Recognition (ASR) and/or 
Text-to-Speech (TTS), install the third-party Media Resource 
Control Protocol (MRCP) speech server host and ensure it is 
operational.
For information about prerequisite software, see 
“Prerequisites” on page 42.

7. Install Microsoft Internet Information Server (IIS) on the 
Windows hosts. 

For supported versions of Microsoft IIS, see “Prerequisites” 
on page 42.

Prepare your environment (continued) 8. Configure the required Windows services and settings on 
the systems that will host GVP components. 

See “Windows Services and Settings” on page 55.

Table 9: Task Summary—Installing GVP Manually (Continued) 

Objective Related Procedures and Actions
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Prepare the GVP host(s) 1. Create a new GVP host in Configuration database (using 
Genesys Administrator).

Create a new host in the Configuration database for each 
machine that hosts GVP components.
See Adding a new GVP host in Genesys Administrator, 
page 60.

2. Install the Local Control Agent on the GVP host(s). 
See Installing the Local Control Agent on a GVP host, 
page 61.

Stop antivirus software that may be 
running on systems that will host GVP 
components.

Check the vendor documentation for your antivirus software 
configuration.

Complete the pre-installation activities. 1. Import the Application object templates. See Importing 
Application object templates to the Configuration 
database, page 63.

2. Create the Application objects. See Creating Application 
objects in the Configuration database, page 68.

Install GVP Install the GVP components:
1. Install the Squid caching proxy. See Installing the Squid 

caching proxy, page 70.

2. Install the Fetching Module. See Installing the Fetching 
Module, page 71.

3. Install the Media Control Platform. See Installing the 
Media Control Platform, page 73.

4. Install the Call Control Platform. See Installing the Call 
Control Platform, page 75.

5. Install the Resource Manager. See Installing Resource 
Manager, page 76.

6. Install the Reporting Server. See Installing the Reporting 
Server, page 77.

Perform post-installation activities: Perform the post-installation activities to provision the 
components for the functionality you want use in your 
deployment. See Chapter 6 on page 81:
Provision the GVP components:

Table 9: Task Summary—Installing GVP Manually (Continued) 

Objective Related Procedures and Actions
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Perform post-installation activities: 
(continued)

1. Schedule a Task. See Scheduling a task for the Squid 
caching proxy, page 82.

2. Create a Solution object. See Creating a Resource 
Solution object, page 83.

3. Integrate Application objects. See Integrating Application 
objects with Resource Manager, page 86.

4. Connect to a Server. See Creating a connection to a 
server, page 89.

5. Create Speech Resource objects. See:
a. Provisioning Speech Resource objects, page 90.
b. Assigning the MRCP server to the Media Control 

Platform, page 92.

6. Prepare to make a call. See Preparing the Call Control 
Platform to make outbound calls, page 93.

7. Configure a Gateway or Resource Access Point. See:
a. Creating a Gateway Application object in the 

Configuration database, page 96.
b. Creating connections in the Resource Manager 

Application object, page 98.

8. Configure Resource types. See Creating a Logical 
Resource Group, page 100.

9. Create an IVR Profile. See:
a. Creating IVR Profiles in the Resource Manager, 

page 104.
b. Updating the Environment Tenant data, page 110.

10. Provision the Reporting Server. See:
a. Configuring the Reporting Server user interfaces, 

page 112.
b. Configuring Reporting Server logging and messaging 

options, page 114.

11. Install the database. See “Creating the Reporting Server 
Databases” on page 115.

For supported databases and versions, see “Prerequisites” on 
page 42.

Table 9: Task Summary—Installing GVP Manually (Continued) 

Objective Related Procedures and Actions
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4 Preparing Your 
Environment
This chapter describes how to prepare your environment for Genesys Voice 
Platform (GVP) 8.0 deployments on Windows hosts.
It contains the following section:

Windows Services and Settings, page 55
For information about all the software prerequisites for Windows deployments, 
see “Prerequisites” on page 42.

Windows Services and Settings
Table 10 summarizes the required services and settings you must configure on 
each GVP host. You must configure these settings before you install GVP.

Warning! When you name a computer, do not use the underscore (_) 
character, even though Windows Setup permits this. Using the 
underscore character causes serious problems with several web 
services that the GVP software uses.

Table 10: Specifying Windows Services and Settings

Objective Related Procedures and Actions

Enable or disable the required services, and set 
service start modes.

For the required services settings, see Table 11 on 
page 56.
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Windows Services
Table 11 lists the Windows Services settings that are required on each GVP 
host computer:

Specify the recommended system 
performance settings.

See Configuring system performance settings, 
page 58.

Modify Windows Registry settings. Accommodate environments with large numbers of 
concurrent calls by changing a Windows Registry 
parameter on all GVP hosts before you begin the 
deployment. 
If your environment is planned to reach call volumes 
over 200 concurrent calls, use the regedit.exe 
command to add a DWORD parameter to the registry 
key as shown in this example:
HKEY_LOCAL_MACHINE/SYSTEM/CurrentControlSet/
Services/tcpip/Parameters

Add DWORD parameter: TcpTimedWaitDelay
with decimal value: 30 (or hex value: 1e)
The minimum value for this parameter is 30 seconds. 
If a value less than 30 is specified, the DWORD resets 
to the default of 240 seconds.
Reboot the computer after modifying the Windows 
System Registry.

Table 10: Specifying Windows Services and Settings (Continued) 

Objective Related Procedures and Actions

Table 11: Windows Services

Name Startup Type

Alerter Disabled

Application Management Manual

Clipbook Manual

Com + Event System Manual

Computer Browser Disabled

Event Log Automatic

FTP Publishing Services Automatic
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System Settings
This section describes the system and system performance settings that 
Genesys recommends.

IIS Admin Service Automatic

Indexing Service Disabled

License Logging Disabled

Messenger Disabled

Net Logon Manual

Network DDE Manual

NT LM Security Support Provider Manual

Plug and Play Automatic

Protected Storage Automatic

Remote Procedure Call (RPC) Automatic

Remote Procedure Call (RPC) Locator Manual

Server Automatic

SNMP Service Automatic

SNMP Trap Service Manual

System Event Notification Automatic

Task Scheduler Automatic

TCP/IP NetBIOS Helper Automatic

Telephony Manual

Uninterruptible Power Supply (UPS) Manual

Workstation Automatic

World Wide Web Publishing Service Automatic

Table 11: Windows Services (Continued) 

Name Startup Type
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Procedure:
Configuring system performance settings

Purpose:  To maximize the performance of each GVP host in your deployment.

Start of procedure

1. In the Windows Control Panel, select System.
2. Click the Advanced tab.
3. In the Performance section, click Settings.
4. The Performance Options dialog box appears.
5. Click the Advanced tab.
6. In the Processor scheduling section of the Advanced tab, select Background 

services.

7. Set the Virtual memory size:
a. In the Virtual memory section of the Advanced tab, click Change.

The Virtual Memory dialog box appears.
b. Select Custom size, and then set the following:

• Initial size (MB): 1.5 times your RAM
• Maximum size (MB): 2 times your RAM

c. Click Set.
8. Click OK to exit all dialog boxes.
9. When prompted, restart the computer.

End of procedure

Next Steps

• No further steps are required.
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5 Installing GVP Manually
This chapter describes how to install Genesys Voice Platform by using the 
executable files in the GVP Installation Packages and Genesys Administrator 
to import Application object templates and install Application objects 
individually. 
It contains the following sections:

Preparing the GVP Hosts, page 59
Pre-Installation Activities, page 63
Installing the GVP Components, page 70

Preparing the GVP Hosts
In a Management Framework environment, servers hosting Genesys 
components propagate their configuration information to the Configuration 
Server. To facilitate this, the Genesys Local Control Agent (LCA) must be 
installed on each GVP host.
In addition, each new host is created in the Configuration database through the 
Genesys Administrator so that the Configuration Server is aware that they are 
present.

Note: Ensure that you are using the Multi-tenant Configuration Server in the 
Management Framework environment. Using the Multi-tenant 
Configuration Server ensure that the Environment tenant is accessible 
for the GVP Resource Manager.
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Adding New GVP Hosts
This section contains the following procedures to prepare the GVP host(s) 
before the GVP components are installed:
• Adding a new GVP host in Genesys Administrator on page 60
• Installing the Local Control Agent on a GVP host on page 61

Procedure:
Adding a new GVP host in Genesys Administrator

Purpose:  To add and configure a host to the Configuration database by using 
Genesys Administrator, thereby facilitating the communication with the 
Configuration Server.

Summary

Each GVP host is added as a new host in Genesys Administrator so that it can 
be controlled and monitored by the User Interaction Layer. The User 
Interaction Layer starts and stops applications, detects application failures, and 
communicates application roles in a redundancy context.

Prerequisites

• Genesys Administrator is installed and operational in the Management 
Framework and accessible from a GVP host.

• You have obtained the Universal Resource Locator (URL) of Genesys 
Administrator.

• The SNMP Master Agent is installed and configured on the same host(s) as 
the Resource Manager, Media Control Platform, Call Control Platform, 
and Fetching Module components.

Note: The SNMP Master Agent is only required if you are capturing 
alarm and trap information. For more information about installing 
the Management Framework and the SNMP Master Agent, see the 
Framework 8.0 Deployment Guide.

Start of procedure

1. In a web browser, type the URL to Genesys Administrator—for example, 
http://<Genesys Administrator host>/wcm/.

2. On the Provisioning tab, click Environment > Hosts> New.
3. In the General section of the Configuration tab, enter the information that 

identifies the host, as shown in Table 12
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.

4. Click Apply to apply the changes.
5. Click Save.

End of procedure

Next Steps

• Install the Local Control Agent on the GVP host. See Installing the Local 
Control Agent on a GVP host, page 61.

Procedure:
Installing the Local Control Agent on a GVP host

Purpose:  To install and configure the Local Control Agent on a GVP host in a 
Windows deployment.

Summary

The Local Control Agent must be installed on every host that is controlled and 
monitored by the Solution Control Server (SCS).

Table 12: Host Properties - Genesys Administrator

Field Description

Name: Enter the hostname of the GVP host—for 
example, MCP1.

IP Address: Enter the IP address of the GVP host.

OS Type: Select the Operating System (OS) type from the 
drop-down list.
(For GVP 8.0, Windows2003 SP2 [or later] is the 
only supported OS.)

OS Version: Enter the version number of the OS installed on 
the GVP host.

LCA Port: The LCA port number 4999 is entered by default.

Solution Control 
Server:

Browse to select the Solution Control Server.

State: Select Enabled from the drop-down list.
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Prerequisites

• The servers on which you install GVP components meet the GVP system 
requirements. For more information about the GVP requirements for 
Windows, see “Prerequisites” on page 42 and “Windows Services and 
Settings” on page 55.

• The Fully Qualified Domain Names (FQDN) of Genesys servers must not 
contain special characters, such as the underscore _.

Note: To ensure that Genesys software works properly, FQDNs must 
contain only standard characters, such as letters A–Z, a–z, digits 0–
9, and hyphens -.

• Third-party software, especially antivirus software, is stopped on the 
servers on which GVP software will be installed

• You have obtained the Genesys Management Framework CDs or a 
network path and the location the Local Control Agent software. For the 
directory structure of the Installation CDs, see the Framework 8.0 
Reference Guide.

Start of procedure

1. On the GVP host, navigate to the directory that contains the installation 
files for the Local Control Agent and execute the file setup.exe.

2. In the Installation Wizard, enter the information that identifies the host, as 
shown in Table 13:

3. Click Next.
4. Restart the host computer.

Table 13: Host Properties—Installation Wizard

Field Description

Name: Enter the hostname of the Configuration Server—
for example, Config1.

Port: Enter the port number of the Configuration 
Server. The default is 2020.

User: Enter a username for the Configuration Server—
typically default.

Password: Enter a password for the Configuration Server—
typically password.
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5. After the host is restarted, open Windows Services to verify that the Genesys 
Local Control Agent is installed and running.

End of procedure

Next Steps

• Complete the Pre-installation activities. See “Pre-Installation Activities” 
on page 63.

Pre-Installation Activities
Before you begin to install the Genesys Voice Platform components manually, 
create an Application object in the Configuration Database for each 
application you are installing.
This section describes how to create Application objects in the Configuration 
Database.

Creating Application Objects
This section describes how to import Application object templates and create 
Application objects in the Configuration Database by using these templates.
It contains the following procedures:
• Importing Application object templates to the Configuration database, 

page 63
• Creating Application objects in the Configuration database, page 68

Procedure:
Importing Application object templates to the 
Configuration database

Purpose:  To import an Application object or Speech Resource object template 
to the Configuration Database prior to installing the Application or Speech 
Resource object.

Summary

Each Application and Speech Resource object created in the Configuration 
Database requires an object template. The templates are imported from the 
GVP installation CDs or copied to a network directory and imported by 
navigating a network path. After a template is imported, it can be used for 
subsequent instances of the same component. For example, if you are installing 
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more than one Media Control Platform host, you can use the same template for 
each Media Control Platform Application object.

Note: For best practice, import all of the Application and Speech Resource 
object templates required before you begin to deploy the components.

See Table 16 on page 66 and Table 17 on page 67 for the names and locations 
of the templates on the installation CDs.

Prerequisites

• The GVP host(s) are prepared for deployment. See Table 9 on page 51.

Start of procedure

1. Log in to Genesys Administrator.
2. In the Login dialog box, enter the information as shown in Table 14.
.

3. Click OK.
Genesys Administrator appears.

4. On the Provisioning tab, click Environment > Application Templates.
5. In the Tasks pane, click Import Application Template.

A Waiting dialog box appears.
6. Click Add.

See Figure 2 on page 65 for an example of the dialog box to add the .apd 
template file.

Table 14: Genesys Administrator Login

Field Description

User Name: Enter the username, typically default.

Password: Enter the password, typically password.

Application: Enter the application name of the Configuration Server, 
typically default.

Host Name: Enter the host name of the Configuration Server—for 
example, ConfgS1.

Port: Enter the port number of the Configuration Server, 
typically 2020.
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Figure 2: Importing .apd Template

7. In the Choose File dialog box, navigate to the directory that contains the 
application or speech resource object templates.
See Table 16 on page 66 and Table 17 on page 67 for the template 
filenames and location.

8. Double-click <template_filename>.apd,
where <template_filename> is the filename of the template you want to 
import.
The template is imported and the Configuration tab appears.

9. Click Import Metadata as shown in Figure 3.

Figure 3: Import Metadata

10. In the Waiting dialog box, click Add.
11. In the Choose File dialog box, navigate to the directory that contains the 

application or speech resource object templates.
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12. Double-click <template_filename>.xml,
where <template_filename> is the name of the file that contains the 
metadata.
The metadata for the template is imported and the Configuration tab 
appears.

13. In the General section, enter the information that identifies the template, as 
shown in Table 15.

14. Click Save.

Note: Add an Application or Speech Resource object template for each 
GVP component or MRCP speech resource you want to install 
before you begin the installation.

Table 15: Application Template Properties

Field Description

Name: Enter a descriptive name for the template—for example, 
GVP_FM_template.

Type: Click the down arrow to select the template type from the 
drop-down list:
• For the GVP Application objects select the template 

with the same name—for example, for the Fetching 
Module, select GVP Fetching Module.

• For all MRCP client objects, select Third-Party 
Server.

Version: Enter the template version number—for example, 8.0 or 
select it from the drop-down list.

State enabled: From the drop-down list, select Enabled.

Table 16: Template and Metadata Files

Application Object Filename

Location: <Genesys Solutions Dir>\Templates\<filename>

Fetching Module VP_FetchingModule_8xx.apd

VP_FetchingModule_8xx.xml

Resource Manager VP_ResourceManager_8xx.apd

VP_ResourceManager_8xx.xml
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End of procedure

Next Steps

• Create the Application or Speech Resource objects in the Configuration 
Database. See Creating Application objects in the Configuration database, 
page 68.

Media Control Platform VP_MediaControlPlatform_8xx.apd

VP_MediaControlPlatform_8xx.xml

Call Control Platform VP_CallControlPlatform_8xx.apd

VP_CallControlPlatform_8xx.xml

Reporting Server VP_ReportingServer_8xx.apd

VP_ReportingServer_8xx.xml

Cluster Manager VP_clusterManager_8xx.apd

VP_clusterManager_8xx.xml

Table 17: MRCP Speech Resource Object Templates

Speech Resource 
Object

Filename

Location: <Genesys Solutions Dir>\Templates\<filename>

MRCPv2 ASR VP_MCP_MRCPv1_ASR_8xx.apd

VP_MCP_MRCPv1_ASR_8xx.xml

MRCPv1 TTS VP_MCP_MRCPv1_TTS_8xx.apd

VP_MCP_MRCPv1_TTS_8xx.xml

MRCPv2 ASR VP_MCP_MRCPv2_ASR_8xx.apd

VP_MCP_MRCPv2_ASR_8xx.xml

MRCPv2 TTS VP_MCP_MRCPv2_TTS_8xx.apd

VP_MCP_MRCPv2_TTS_8xx.xml

Table 16: Template and Metadata Files (Continued) 

Application Object Filename



68 Genesys Voice Platform 8.0

Chapter 5: Installing GVP Manually Pre-Installation Activities

Procedure:
Creating Application objects in the Configuration 
database

Purpose:  To create an Application or Speech Resource object in the 
Configuration Database for the application or speech resource being installed.

Prerequisites

• An Application or Speech Resource object template is imported for the 
type of object you are installing. See Importing Application object 
templates to the Configuration database, page 63.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Applications > New.

The Browse..\Application Templates\ dialog box opens to display the 
contents of the Application Templates directory (see Figure 4).

Figure 4: Browse Application Templates

3. Click the Application or Speech Resource object template for the object 
you want to create. (See Table 16 on page 66 and Table 17 on page 67 for a 
list of template filenames.)
The Configuration tab appears, with some of the fields in the General 
section populated and disabled.

4. In the Name field, enter the name of the application—for example, 
Fetch_Module.

5. In the State field, retain the default value, Enabled.
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6. In the Server Info section, enter the information as shown in Table 18.

Note: Table 18 contains only the required fields, that is, those fields that 
have an asterisk in front of the field name. The required fields must 
be populated before you can save the configuration.

Table 18: Application Object Properties

Field Description

Host: Enter the name of the computer that is hosting the application—for example, 
GVP-host1 or browse to select from a list of available hosts.

Working Directory: Enter any value in these fields as temporary placeholders—for example \.
These characters are replaced by the proper values when the component is 
installed.Command Line:

StartUp Timeout Enter the time interval, in seconds, during which the User Interaction Layer 
should expect this application to start.
The default is 90 seconds.
If the application is configured with the Autostart configuration option set to 
True, this is also the time that Solution Control Server waits after initializing 
or after a system reboot, to start this application.

ShutDown Timeout Enter the time interval, in seconds, during which the User Interaction Layer 
should expect this application to shutdown.
The default is 90 seconds.

Redundancy Type Click the down arrow to select the type of redundancy in which you want this 
application to run.

Timeout Enter a time interval, in seconds, that the client application should wait 
between reconnect attempts after a connection failure with the server.
The default is 10 seconds.

Attempts Enter the number of attempts to reconnect to this server before trying to 
connect to the backup server.
The default value is 1.
This value must be 1 or higher and makes sense only if you specify a backup 
server for this server.

Auto Restart Click the down arrow to select True or False.
The default value is False.
Selecting True causes the User Interaction Layer to automatically restart the 
application after it fails. Selecting False prevents the User Interaction Layer 
from automatically restarting the application after it fails.
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Note: Although the parameters in Table 18 on page 69 are not used by the 
Configuration database when Speech Resource objects are created, 
the required fields must be populated before you can save the 
configuration. If you are creating Speech Resource objects, retain 
the default values for the StartUp Timeout, Shutdown Timeout, 
Redundancy Type, Timeout, Attempts, and Auto Restart fields.

7. Click Save.

End of procedure

Next Steps

• Install the GVP components. See “Installing the GVP Components”.

Installing the GVP Components
This section describes how to install GVP in a new deployment or to add GVP 
components to an existing deployment.
This section contains the following procedures:
• Installing the Squid caching proxy, page 70
• Installing the Fetching Module, page 71
• Installing the Media Control Platform, page 73
• Installing the Call Control Platform, page 75
• Installing Resource Manager, page 76
• Installing the Reporting Server, page 77

Procedure:
Installing the Squid caching proxy

Purpose:  To install and start the Squid caching proxy on the Media Control 
Platform and Call Control Platform hosts.

Note: The Squid software is not required on the Resource Manager, or on 
Reporting Server hosts.

Prerequisites

• The requirements for Windows software are met. See Table 8 on page 42.
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Start of procedure

1. Execute the file, setup.exe:
• If you are using the GVP software CD, browse to 

<GVPCD>\gvp\windows\Squid\, where <GVPCD> is the CD drive letter.
• If the CD image is on a network drive, copy the 

<CDImage>\gvp\windows\Squid\ folder to the local machine.
2. When the Installation Wizard appears, click Next.

Note: To avoid having to make manual configuration changes after 
installation, install the Squid caching proxy in the default directory, 
C:\Squid.

3. After the installation wizard is complete, click Finish.
4. Reboot the host computer.

Start the Service

5. At the host computer, click Start > Programs > Administrative Tools > 
Services.

6. In the Component Services window, click Services (Local).
7. In the Services list, check to ensure that the service is running. 
8. Right-click on SquidNT to select Start, if it is not started.
9. Click OK.

End of procedure

Next Steps

• Install the Fetching Module. See Installing the Fetching Module.

Procedure:
Installing the Fetching Module

Purpose:  To install the Fetching Module component on the Media Control 
Platform or Call Control Platform host. All Media Control Platform and Call 
Control Platform hosts require the Fetching Module.

Note: The Fetching Module is required on the Media Control Platform and 
Call Control Platform hosts.
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Prerequisites

• The Squid caching proxy is installed and the service started. See Installing 
the Squid caching proxy, page 70.

• The Fetching Module host is added in the Configuration database. See 
Adding a new GVP host in Genesys Administrator, page 60.

Note: The Fetching Module and Media Control Platform or Call Control 
Platform must share the same host, therefore the procedure to add a 
host is only done once per host.

• A Fetching Module Application object template is imported to the 
Configuration database. See Importing Application object templates to the 
Configuration database, page 63.

• A Fetching Module Application object is created in the Configuration 
database. See Creating Application objects in the Configuration database, 
page 68.

Start of procedure

1. Execute the file, setup.exe:
• If you are using the GVP software CDs, browse to 

<GVP_Installation_CD>\gvp\windows\fm\, where 
<GVP_Installation_CD> is the CD drive letter.

• If the CD image is on a network drive, copy the 
<CDImage>\gvp\windows\fm\ folder to the local machine.

2. When the Genesys Installation Wizard appears, click Next.
3. Enter the information in the Host and User sections as shown in Table 19.

These are the connection parameters for the Configuration Server.

4. Click Next.

Table 19: Connection parameters for Configuration Server

Section Field Description

Host Host name: Enter the host name or the IP address of 
the Configuration Server.

Port: Enter the port number for the 
Configuration Server.

User User name: Enter the username used to logon to the 
Configuration Server.

Password: Enter the password used to logon to the 
Configuration Server.
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5. Select the Fetching Module Application object and click Next.
6. Select the destination folder:

• Click Next to accept the default directory or,
• Click Browse to choose the destination folder, and click Next.

7. When the Ready to Install dialog box appears, click Install.
8. After the installation is complete, click Finish.

End of procedure

Next Steps

• Start the Fetching Module Application object. See Starting and Stopping 
GVP, page 119.

• Install the Media Control Platform. See Installing the Media Control 
Platform, page 73.

Procedure:
Installing the Media Control Platform

Purpose:  To install the Media Control Platform component so that SIP 
applications using VoiceXML can access the Media Control Platform media 
services.

Prerequisites

• The Squid Caching proxy is installed on the Media Control Platform host 
and the service started. See Installing the Squid caching proxy, page 70.

• The Fetching Module is installed on the Media Control Platform host. See 
Installing the Fetching Module, page 71.

• A Media Control Platform Application object template is imported to the 
Configuration database. See Importing Application object templates to the 
Configuration database, page 63.

• A Media Control Platform host is created in the Configuration database. 
See Adding a new GVP host in Genesys Administrator, page 60.

• A Media Control Platform Application object is created in the 
Configuration database. See Creating Application objects in the 
Configuration database, page 68.

Note: The Fetching Module and Media Control Platform or Call Control 
Platform must share the same host, therefore the procedure to create a 
host in the Configuration Database is done only once for each host 
computer.
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• Microsoft Internet Information Server (IIS) is installed. See “Prerequisites” 
on page 42.

Start of procedure

1. Execute the setup file, setup.exe:
• If you are using the GVP software CDs, browse to 

<GVP_Installation_CD>\gvp\windows\mcp\.

• If the CD image is on a network drive, copy the 
<CDImage>\gvp\windows\mcp\ folder to the local machine.

2. When the Genesys Installation Wizard appears, click Next.
3. Select the audio format for your region;

• Mulaw (North America) or,
• Alaw (Europe).

4. In the Connection Parameters dialog box, enter the information in the Host 
and User sections as shown in Table 19 on page 72.
These are the connection parameters for the Configuration Server.

5. In the Select Application dialog box, select the Media Control Platform 
Application object you want to install.

6. In the Choose Destination dialog box:
• To accept the default location, click Default or,
• To choose an alternate location, click Browse.

7. In the VP Reporting Server section, enter the information as shown in 
Table 20.

8. In the Ready to Install dialog box, click Install.
9. When the installation is complete, click Finish.

End of procedure

Next Steps

• Start the Media Control Platform Application object. See Starting and 
Stopping GVP, page 119.

Table 20: VP Reporting Server section

Field Description

Host Enter the hostname of the Reporting Server—for 
example, ReportServ1.

Port Accept the default value 61616 for the Reporting Server 
port number.
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• Install the Call Control Platform. See Installing the Call Control Platform, 
page 75.

Procedure:
Installing the Call Control Platform

Purpose:  To install the Call Control Platform component so that applications 
using CCXML can access the Call Control Platform call processing services.

Prerequisites

• The Squid caching proxy is installed on the Media Control Platform host 
and the service started. See Installing the Squid caching proxy, page 70.

• The Fetching Module is installed on the Call Control Platform host. See 
Installing the Fetching Module, page 71.

• The Call Control Platform Application object template is imported to the 
Configuration database. See Importing Application object templates to the 
Configuration database, page 63.

• A Call Control Platform host is created in the Configuration database. See 
Adding a new GVP host in Genesys Administrator, page 60.

Note: The Fetching Module and Media Control Platform or Call Control 
Platform must share the same host, so the procedure to add a host is 
only done once per host.

• A Call Control Platform Application object is created in the 
Configuration database. See Creating Application objects in the 
Configuration database, page 68.

Start of procedure

1. Execute the file, setup.exe:
• If you are using the GVP software CDs, browse to 

<GVP_Installation_CD>\gvp\windows\ccp\.

• If the CD image is on a network drive, copy the 
<CDImage>\gvp\windows\ccp\ folder to the local machine.

2. When the Genesys Installation Wizard opens, click Next.
3. In the Connection Parameters dialog box, enter the information in the Host 

and User sections as shown in Table 19 on page 72.
These are the connection parameters for the Configuration Server.

4. In the Select Application dialog box, select the Call Control Platform 
Application object you want to install.

5. In the Choose Destination dialog box:
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• To accept the default location, click Default or,
• To choose an alternate location, click Browse.

6. In the VP Reporting Server section, enter the information as shown in 
Table 20 on page 74.

7. In the Ready to Install dialog box, click Install.
8. When the installation is complete, click Finish.

End of procedure

Next Steps

• Start the Call Control Platform Application object. See Starting and 
Stopping GVP, page 119.

• Install Resource Manager. See Installing Resource Manager.

Procedure:
Installing Resource Manager

Purpose:  To install Resource Manager on the host.

Prerequisites

• The Management Framework is installed and fully operational. This is 
done before you configure and operate the Resource Manager. See the 
Framework 8.0 Deployment Guide.

• The SNMP Master Agent is installed and configured on the Resource 
Manager host. For information about the SNMP Master Agent and 
installation procedures, see the Framework 8.0 Deployment Guide.

• The Resource Manager Application object template is imported to the 
Configuration database. See Importing Application object templates to the 
Configuration database, page 63.

• The Resource Manager host is created in the Configuration database. See 
Adding a new GVP host in Genesys Administrator, page 60

• An Resource Manager Application object is created in the Configuration 
database. See Creating Application objects in the Configuration database, 
page 68.

Start of procedure

1. Execute the file, setup.exe:
• If you are using the GVP software CDs, browse to 

<GVP_Installation_CD>\gvp\windows\rm\.
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• If the CD image is on a network drive, copy the 
<CDImage>\gvp\windows\rm\ folder to the local machine.

2. When the Genesys Installation Wizard appears, click Next.
3. In the Connection Parameters dialog box, enter the information in the Host 

and User sections as shown in Table 19 on page 72.
These are the connection parameters for the Configuration Server.

4. In the Select Application dialog box, select the Resource Manager 
Application object.

5. In the Choose Destination dialog box:
• To accept the default location, click Default or,
• To choose an alternate location, click Browse.

6. In the VP Reporting Server section, enter the information as shown in 
Table 20 on page 74.

7. In the Ready to Install dialog box, click Install.
8. When the installation is complete, click Finish.

End of procedure

Next Steps

• Start the Resource Manager Application object. See Starting and Stopping 
GVP, page 119.

• Install the Reporting Server. See Installing the Reporting Server, page 77.

Procedure:
Installing the Reporting Server

Purpose:  To install and provision the Reporting Server on the host.

Prerequisites

• Management Framework is installed and fully operational. See the 
Framework 8.0 Deployment Guide.

• Jakarta Tomcat 6.0.16 and Sun JDK 6, Update 5 are installed.

Note: When the Jakarta Tomcat application server is installed, ensure that 
it is not set to run automatically. Users should select No for this 
option when prompted by the installation wizard.

• A Reporting Server host is created in the Configuration database. See 
Adding a new GVP host in Genesys Administrator, page 60
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• The Reporting Server Application object template is imported to the 
Configuration database. See Importing Application object templates to the 
Configuration database, page 63.

• A Reporting Server Application object is created in the Configuration 
database. See Creating Application objects in the Configuration database, 
page 68

Start of procedure

1. Execute the file, setup.exe:
• If you are using the GVP software CDs, browse to 

<GVP_Installation_CD>\gvp\windows\rs\.

• If the CD image is on a network drive, copy the 
<CDImage>\gvp\windows\rs\ folder to the local machine.

2. When the Genesys Installation Wizard appears, click Next.
3. In the Connection Parameters dialog box, enter the information in the Host 

and User sections as shown in Table 19 on page 72.
These are the connection parameters for the Configuration Server.

4. In the Select Application dialog box, select the Reporting Server 
Application object.

5. In the Choose Destination dialog box:
• To accept the default location, click Default or,
• To choose an alternate location, click Browse.

6. In Select the Installed Sun’s Java Runtime Environment (JRE), select 
the runtime environment for your deployment.

7. For the Database Engine Option, select one of two options:
• Microsoft SQL: Server (MS SQL) or,
• Oracle

Note: The Microsoft SQL Server and Oracle 10 g DB Servers are the 
only supported databases. See “Prerequisites” on page 42

8. In the VP Reporting Server Parameters dialog box, enter the parameters as 
shown in Table 21 on page 79

Note: In Table 21, the terms DB Server and database server refer to the 
server that hosts the database software—for example, Oracle or 
SQL Server—and not the Management Framework Configuration 
DB Server.
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9. In the VP Reporting Server section, accept the default port number 61616.
10. In the Ready to Install dialog box, click Install.
11. When the installation is complete, click Finish.

End of procedure

Next Steps

• Start the Reporting Server Application object. See Starting and Stopping 
GVP, page 119.

• Create a GVP Solution Object. See Creating a Resource Solution object, 
page 83.

Table 21: VP Reporting Server Parameters

Section Field Description

Database 
Server

DB Server Host Enter the hostname or IP address and the 
instance—if defined, on which the SQL 
Server or Oracle is installed.

DB Server Port Enter the port number of the database 
server host—typically, 1433.

Database Database Name Enter the name of the database—for 
example, db_rs.

User User Name Enter the user name you want to use to 
connect to the database.

Password Enter the password you want to use to 
connect to the database.
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Chapter

6 Post-Installation Activities 
on the GVP Hosts
Some Genesys Voice Platform (GVP) components require additional 
configuration to initiate the advanced features and optimize operation.
This chapter contains post-installation activities for the GVP hosts, 
information about creating the database and schema for the Reporting Server, 
and describes how to start and stop GVP components in all deployments.
It contains the following sections:

Provisioning the Components, page 81
Creating the Reporting Server Databases, page 115

Provisioning the Components
After you have installed the GVP components and performed the basic 
configuration, some additional steps are necessary to configure the advanced 
features of the GVP components. 
This section contains advanced configuration procedures for the following 
components.
• Scheduling a Task for the Squid Proxy on page 82
• Creating Solution Objects on page 83
• Integrating Application Objects on page 85
• Connecting to a Server on page 89
• Using Speech Resources with GVP on page 90
• Preparing to Make an Outbound Call on page 93
• Configuring Gateways, Resource Types, and IVR Profiles on page 94
• Configuring the Reporting Server User Interface and Options on page 111
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Scheduling a Task for the Squid Proxy
After the Squid caching proxy is installed, schedule a daily task in Windows 
Scheduler to rotate the logs for this service. The Squid proxy is a third-party 
application, therefore the logs are not automatically rotated.
Use the procedure in this section to schedule a task to rotate the Squid caching 
proxy service logs.

Procedure:
Scheduling a task for the Squid caching proxy

Purpose:  To schedule a daily task to rotate the Squid caching proxy service 
logs.

Prerequisites

• Squid caching proxy is installed and service is running. See Installing the 
Squid caching proxy, page 70.

Start of procedure

1. From the Windows Start menu, select All Programs > Accessories > 
Notepad.

2. Enter the following script:
@echo 

C:\squid\sbin\squid.exe -k rotate -n SquidNT

@pause 

@echo 

3. Click File > Save As.
4. Save the file with the extension .bat—for example, SquidTask.bat.
5. From the Windows Start menu, select All Programs > Accessories > 

System Tools > System Tasks.

6. Double-click Add Scheduled Task.
The Scheduled Task Wizard appears.

7. Click Next.
8. Click the Browse button to browse to the file you created in Step 4 of this 

procedure.
9. Double-click the file.

The Scheduled Task Wizard automatically populates the Task Name field.
10. In the Perform this task: section, select Daily.
11. Click Next.
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12. In the Start Time field, enter 2:12 AM.
13. Select the Every Day radio button.
14. In the Start Date field, enter the date that you want the task to start—for 

example, 5/12/2008.
15. Click Next.
16. In the user name field, enter the username of the person who is scheduling 

the task.
17. In the Password and Confirm Password fields, enter the password.
18. Click Next.
19. Click Finish.

End of procedure

Next Steps

• Continue with the Post Installation procedures in this chapter. See 
“Creating Solution Objects”.

Creating Solution Objects
Creating a Solution object is not a requirement for a successful deployment, 
but recommended as an efficient way to manage two or more Application 
objects. In this case, a Resource Solution object is created to ensure that the 
Fetching Module is started prior to the Media Control Platform or Call Control 
Platform. The priorities that are set affect all of the components within the 
Resource Solution object.

Procedure:
Creating a Resource Solution object

Purpose:  To create a Resource Solution object that combines two or more 
components to facilitate a unified management function.

Note: The Fetching Module must be started before the Media Control 
Platform and the Call Control Platform is started. If the Fetching 
Module stops for any reason, the Media Control Platform and the Call 
Control Platform must also be stopped, then restarted after the Fetching 
Module is restarted.
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Prerequisites

• Two or more GVP components are installed for which a Resource Solution 
object is required. See “Installing the GVP Components” on page 70.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, click Environment > Solutions > New.

The Configuration tab appears.
3. In the General section, enter the information as shown in Table 22.
ion

4. In the Components section, click Add.
The Solution Component dialog box appears.

5. Enter the information as show in Table 23.

6. Click OK.
7. The Fetching Module appears in the Solution Components field.

Table 22: Solution Parameters--General Section

Field Description

Name Enter a name for the Solution object—for example, VP-
SPSol.

Solution Type From the drop-down list, select Voice Self Service.

Solution Control 
Server

Browse to select the Solution Control Server from the 
Applications list.

Version Enter the version number—for example, 8.0.

State From the drop-down list, select Enabled.

Table 23: Solution Components

Field Description

Application From the drop-down list, select the Fetching Module 
Application object.

Startup Priority Enter a number to set the priority for this application—for 
example, 1.

Optional From the drop-down list, select False.
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8. Repeat steps 4 to 7, and
a. If you are adding a Media Control Platform to the Resource Solution 

object:
• Select the Media Control Platform Application object for 

Application.

• Enter 2 for Startup Priority.
b. If you are adding a Call Control Platform to the Resource Solution 

object:
• Select the Call Control Platform Application object for 

Application.

• Enter 3 for Startup Priority.

Note: The Components Definition section is populated as Application 
objects are added to the Components section. Click the Components 
Definition up arrow to view the populated fields.

9. Click Save.

End of procedure

Next Steps

• Complete the remaining post-installation activities for the GVP 
components.

Integrating Application Objects
After the Media Control Platform and Call Control Platform Application 
objects are created and the components installed, they are integrated with the 
Resource Manager to facilitate communication between them. To integrate 
these Application objects with the Resource Manager, you configure the SIP 
settings.
The procedures in this section describe how to integrate the Media Control 
Platform and Call Control Platform Application objects with the Resource 
Manager by configuring SIP and secure SIP options.
The procedures include:
• Integrating Application objects with Resource Manager, page 86
• Integrating an Application object by using secure SIP, page 88

Note: Although the GVP components support secure SIP capabilities, the 
external SIP server does not. Before you enable SIPS in your 
deployment, contact your Genesys Sales Representative for more 
information.
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Procedure:
Integrating Application objects with Resource 
Manager

Purpose:  To integrate an Application object with Resource Manager by 
configuring the Application object parameters.

Prerequisites

• The GVP components are installed. See “Installing the GVP Components” 
on page 70.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Applications.
3. Click the Application object you want to configure—for example, the 

Media Control Platform or Call Control Platform.
The Configuration tab appears.

4. On the Settings tab, use the Reload drop-down list to filter the section you 
want to configure.

5. From the drop-down list, select SIP Settings.
The list of Settings is filtered and all of the sip section options appear.

Figure 5: Reload Filter—Settings tab

6. Click the routeset option.
The Route Set dialog box appears with a description of the option.

7. In the Value field, type;
• <sip:IP_RM:SIPPort_RM;lr> to integrate the Media Control Platform 

with Resource Manager.
• <sip:IP_RM:SIPPort_RM> to integrate the Call Control Platform with 

Resource Manager.
where IP_RM is the IP address of the Resource Manager and SIPPort_RM is 
the SIP port of the Resource Manager—typically 5060. See Figure 6.
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Figure 6: Application Object—Settings Tab

Note: You must include the angle brackets in the Value field in the 
sip.routeset and sip.securerouteset parameters.

8. In the Value field of the securerouteset option, type;
• <sip:IP_RM:SIPSecurePort_RM;lr> to integrate the Media Control 

Platform with Resources Manager.
• <sip:IP_RM:SIPSecurePort_RM> to integrate the Call Control Platform 

with Resource Manager.
where IP_RM is the IP address of the Resource Manager and 
SIPSecurePort_RM is the SIP secure port of the Resource Manager—
typically 5061.

Note: Although the GVP components support secure SIP capabilities, the 
external SIP server does not. 

9. Click Save.

End of procedure

Next Steps

• Create the connections to the Message Server. See “Connecting to a 
Server” on page 89.
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Procedure:
Integrating an Application object by using secure SIP

Purpose:  To integrate an Application object with Resource Manager by 
configuring the secure SIP parameters of the Application object.

Summary

This procedure is optional and not required unless secure SIP is supported in 
your environment.

Start of procedure

1. Log in to Genesys Administrator.
2. Complete steps 2 to 5 in the procedure, Integrating Application objects 

with Resource Manager, page 86.
3. Click the securerouteset option.

The Secure Route Set dialog box appears with a description of the option.
4. In the Value field, type;

• <sip:IP_RM:SIPSecurePort_RM;lr> to integrate the Media Control 
Platform with Resources Manager.

• <sip:IP_RM:SIPSecurePort_RM> to integrate the Call Control Platform 
with Resource Manager.

where IP_RM is the IP address of the Resource Manager and 
SIPSecurePort_RM is the SIP secure port of the Resource Manager—
typically 5061.

Note: Although the GVP components support secure SIP capabilities, the 
external SIP server does not. 

5. Click Save.

End of procedure

Next Steps

• Create the connections to the Message Server. See “Connecting to a 
Server” on page 89.

Note: There are additional parameters that can be configured for the 
sip.routeset, sip.securerouteset, and sip. transport options. For a 
complete list and description of these options, see the Settings tab in 
the Media Control Platform or Call Control Platform Application 
object.
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Connecting to a Server
To ensure that the call processing information reaches the Log database, the 
Media Control Platform, Call Control Platform, Fetching Module, and 
Resource Manager require a connection to Message Server.
Use the procedure in this section to create connections to the Message Server.

Procedure:
Creating a connection to a server

Purpose:  To create a connection to the Message Server in an Application 
object.

Prerequisites

• The GVP components are installed. See “Installing the GVP Components” 
on page 70.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Applications.
3. Click the Application object for which you are creating the connection—

for example, the Media Control Platform.
The Configuration tab appears.

4. In the General section, Connections field, click Add.
The Connection Info dialog box appears. See Figure 7.

Figure 7: Application Object—Connection Info

5. In the Server field, click the down arrow to open the Browse Application 
window.
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6. Select the server that you want to create a connection to—for example, 
Message Server.

The required fields in Connection Info populate automatically.
7. Click OK.

The Server you selected in step 6—in this case, Message Server, appears 
under Connections.

8. Click Save.

End of procedure

Next Steps

• Complete the remaining post-installation activities for the Media Control 
Platform. See “Using Speech Resources with GVP” on page 90.

Using Speech Resources with GVP
The Media Resource Control Protocol (MRCP) speech resources are controlled 
by the Call Manager Application Program Interface (CMAPI) which opens and 
closes sessions and provides the speech recognition and speech synthesis 
commands that the MRCP server uses to carry out speech requests.

Note: The procedures in this section are required only if you are using ASR 
and TTS speech resources and have an MRCP server in your 
deployment.

Use the procedures in this section to create the Speech Resource objects and 
assign the MRCP Server to the Media Control Platform.
This section contains the following procedures:
• Provisioning Speech Resource objects, page 90
• Assigning the MRCP server to the Media Control Platform, page 92

Procedure:
Provisioning Speech Resource objects

Purpose:  To create the MRCP Speech Resource objects for Automatic Speech 
Recognition (ASR) and Text-to-Speech (TTS).

Prerequisites

• The GVP components are installed. See Importing Installation Packages 
into the Repository, page 127.
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• The Media Control Platform is integrated with the RM. See Integrating 
Application objects with Resource Manager, page 86.

• A Media Control Platform connection to Message Server is created. See 
Creating a connection to a server, page 89.

• The MRCP Speech Resource object templates are imported. See Importing 
Application object templates to the Configuration database, page 63

• The MRCP Speech Resource objects are created. See Creating Application 
objects in the Configuration database, page 68.

Summary

After a Speech Resource object is created with the basic configuration, it must 
be provisioned with the IP address and port number for the MRCP Server.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Applications.
3. Select the Speech Resource object that you want to configure.

The Configuration tab appears.
4. On the Settings tab, scroll to the provision section.
5. Enter the Value for each Option as shown in Table 24.

6. Click Save.

End of procedure

Table 24: MRCP Application Properties—Settings tab

Option Name Option Value

For MRCPv1

vrm.client.resource.address <MRCP_Serv_IP> 
where the value in brackets is the IP address of the MRCP Server.

vrm.client.resource.uri rtsp://<MRCP_Serv_IP>:4900/media/speechsynthesizer
where the value in brackets is the IP address of the MRCP Server

For MRCPv2

vrm.client.resource.address <MRCP_Serv_IP>, 
where the value in brackets is the IP address of the MRCP Server.

vrm.client.resource.uri sip:mresources@<MRCP_Serv_IP>:5060
where the value in brackets is the IP address of the MRCP Server
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Next Steps

• Assign the MRCP Server to the Media Control Platform Application 
object. See Assigning the MRCP server to the Media Control Platform.

Procedure:
Assigning the MRCP server to the Media Control 
Platform

Purpose:  To assign the MRCP Server to the Media Control Platform 
Application object.

Prerequisites

• The MRCP Speech Resource object templates are imported. See Importing 
Application object templates to the Configuration database, page 63.

• The MRCP Speech Resource objects are created. See Creating Application 
objects in the Configuration database, page 68.

• The MRCP Speech Resource objects are provisioned. See Provisioning 
Speech Resource objects, page 90.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Applications.
3. Double-click the Media Control Platform Application object you want to 

configure.
The Configuration tab appears.

4. In the General section, Connections field, click Add.
The Connection Info dialog box appears.

5. Enter the information in the required fields, as shown in Table 25.

Table 25: Connection Info dialog box

Field Description

Server Browse to select the MRCP Server.

ID This field is populated automatically with value, 
default.
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6. Click OK.
7. To save the configuration, click Save.

Notes: There is no limit to the number of primary or backup MRCP 
servers you can assign to the Media Control Platform; however, do 
not assign the same server as both primary and backup.

End of procedure

Next Steps

• Complete the remaining post-installation activities for the Call Control 
Platform. See “Preparing to Make an Outbound Call” on page 93.

Preparing to Make an Outbound Call
Use the procedure in this section to prepare the Call Control Platform to make 
outbound calls.

Procedure:
Preparing the Call Control Platform to make outbound 
calls

Purpose:  To configure the Call Control Platform Application object to make 
outbound calls.

Prerequisites

• The GVP components are installed. See Importing Installation Packages 
into the Repository, page 127.

• The Call Control Platform is integrated with the RM. See Integrating 
Application objects with Resource Manager, page 86.

Trace Mode This field is populated automatically with value, 
Trace is Turned Off.

Application Parameters Enter provisiontype=primary for a primary 
MRCP server.
Enter provisiontype=backup for a backup 
MRCP server.

Table 25: Connection Info dialog box (Continued) 

Field Description



94 Genesys Voice Platform 8.0

Chapter 6: Post-Installation Activities on the GVP Hosts Provisioning the Components

• A Call Control Platform connection to the Message Server is created. See 
Creating a connection to a server, page 89.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Applications.
3. Click the Call Control Platform Application object.
4. On the Settings tab, scroll to the mediacontroller section.
5. Click the Value field of the sipproxy option.
6. Enter <IP_RM>:<SIPPort_RM>

where IP_RM is the IP address of the Resource Manager and SIPPort_RM is 
the SIP port of the Resource Manager.

7. Click the Value field of the bridge_server.
8. Enter <IP_RM>:<SIPPort_RM>

where IP_RM is the IP address of the Resource Manager and SIPPort_RM is 
the SIP port of the Resource Manager.

9. Click Apply to apply the changes.
10. Click Save.

End of procedure

Next Steps

• Complete the post-installation activities for the Resource Manager. See 
“Configuring Gateways, Resource Types, and IVR Profiles”.

Configuring Gateways, Resource Types, and IVR Profiles
Resource management includes many functions, such as:
• Creating logical groups for multiple Resource Manager Application objects 

(if they are set up in a cluster).
• Assigning physical resources to a logical group.
• Creating connections to Resource Manager to assign physical resources.

Note: For information about setting up the Resource Manager Application 
objects in a cluster, see Appendix B on page 137.

Use the procedures in this section to perform these post-installation 
configuration tasks for the Resource Manager:
• Creating a Gateway Application Object on page 95
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• Setting up Resource Types on page 99
• Setting up IVR Profiles and Dialed Number Mapping on page 104

Creating a Gateway Application Object

To create a Gateway Application object you must first create a Gateway 
Application object template. The Gateway Application object is then created in 
the Configuration Database and a connection is configured to facilitate 
communication between the Gateway and Resource Manager.
This section contains the following procedures:
• Creating the Gateway Application object template
• Creating a Gateway Application object in the Configuration database.
• Creating connections in the Resource Manager Application object.

Procedure:
Creating the Gateway Application object template

Purpose:  To create the Gateway Application object template to provide a 
placeholder so that the SIP Server can be configured as a gateway.

Summary

Unlike other Application object templates, the Gateway Application object 
template does not require metadata and is therefore, not imported.
1. Log in to Genesys Administrator
2. On the Provisioning tab, click Environment > Application Templates.
3. Click New.

The Configuration tab appears.
4. In the General section, enter the information that identifies the template, as 

shown in Table 26.

Table 26: Gateway Application Template Properties

Field Description

Name: Enter a descriptive name for the template—for example, 
Gateway Application template.

Type: Click the down arrow to select the Resource Access 
Point from the drop-down list:
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5. Click Save.

End of procedure

Next Steps

• Create the Gateway Application object. See Creating the Gateway 
Application object template, page 95.

Procedure:
Creating a Gateway Application object in the 
Configuration database

Purpose:  To create a Gateway Application object in the Configuration database 
to facilitate communication between the Resource Manager (and in some 
instances the Call Control Platform or Media Control Platform) and the SIP 
Server.

Summary

Creation of the Gateway Application object in the Configuration database 
differs slightly from the creation of other Application objects in that, you do 
not need to import the metadata for the Application object template. The 
Gateway Application object template is merely a configuration placeholder so 
that the SIP Server can act as a gateway.

Prerequisites

• The Resource Manager Application object is installed with basic 
configuration. See “Installing the GVP Components” on page 70.

• A Gateway Application object template is created using the Resource 
Access point as the Type.

Version: Enter the template version number—for example, 8.0 or 
select it from the drop-down list.

State enabled: From the drop-down list, select Enabled.

Table 26: Gateway Application Template Properties

Field Description
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Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Applications > New.

The Browse Application Template dialog box opens to display the contents 
of the Application Templates directory.

3. Double-click on the Gateway Application object template.
The Configuration tab appears, with some of the fields in the General 
section populated and disabled.

4. In the Name field, enter the name of the application—for example, 
Gateway_App.

5. In the Application Prototype field, click the browse icon to select Gateway 
Application template.

6. In the State field, retain the default value, Enabled.
7. In the Server Info section, enter the information as shown in Table 27.

Notes: Table 27 shows only the required fields, that is, those fields that 
have an asterisk in front of the field name. These fields must be 
populated before you can save the configuration.

Table 27: Gateway Application Properties

Field Description

Host: Enter the name of the Configuration Server host or 
Click the down arrow to select it from a list of available hosts.

Working Directory: Enter any value in these fields as temporary placeholders—for example \.
These characters are replaced by the proper values when the component is 
installed.Command Line:

StartUp Timeout Enter the time interval, in seconds, during which the User Interaction Layer 
should expect this application to start.
The default is 90 seconds.
If the application is configured with the Autostart configuration option set 
to True, this is also the time that Solution Control Server waits after 
initializing or after a system reboot, to start this application.

ShutDown Timeout Enter the time interval, in seconds, during which the User Interaction Layer 
should expect this application to shutdown.
The default is 90 seconds.

Redundancy Type Click the down arrow to select the type of redundancy in which you want this 
application to run.
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8. Click Apply to save the changes.
9. Click OK to close the dialog box.

End of procedure

Next Steps

• Create the connections in the Resource Manager. See Creating connections 
in the Resource Manager Application object, page 98.

Procedure:
Creating connections in the Resource Manager 
Application object

Purpose:  To create connections to the Application objects that the Resource 
Manager manages and with which the Resource Manager needs to 
communicate.

Prerequisites

• The Resource Manager Application object is installed. See “Installing the 
GVP Components” on page 70.

• A Gateway Application object is created in the Configuration Database. 
See Creating a Gateway Application object in the Configuration database, 
page 96.

Timeout Enter a time interval, in seconds, that the client application should wait 
between reconnect attempts after a connection failure with the server.
The default is 10 seconds.

Attempts Enter the number of attempts to reconnect to this server before trying to 
connect to the backup server.
The default value is 1.
This value must be 1 or higher and makes sense only if you specify a backup 
server for this server.

Auto Restart Click the down arrow to select True or False.
The default value is False.
Selecting True causes the User Interaction Layer to automatically restart the 
application after it fails. Selecting False prevents the User Interaction Layer 
from automatically restarting the application after it fails.

Table 27: Gateway Application Properties (Continued) 

Field Description
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Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Applications.
3. Click the Resource Manager Application object to open the application 

properties.
4. In the General section Connections field, click Add.

The Connection Info dialog box appears.
5. In the Server field, click the browse icon to open the Browse Application 

window.
6. Select the Media Control Platform Application object.

The required fields (those with an asterisk) in Connection Info populate 
automatically.

7. Click OK.
The Media Control Platform Application object appears under 
Connections.

8. Click Apply.
9. Repeat steps 4 to 8 to add the Call Control Platform, Gateway Resource 

Access Point.
Add connections to other applications that you want the Resource Manager 
to manage as required for your environment.

Notes: If you require a connection for an external SIP resource, see 
Appendix C, “External SIP Resources” on page 149.

10. Click Save.

End of procedure

Next Steps

• Continue with the post-installation activities for the Resource Manager. 
See “Setting up Resource Types”.

Setting up Resource Types

In Resource Manager, you can set up resource types by creating a Logical 
Resource Group that consists of two or more components that need access to a 
common type of service, such as VoiceXML, CCXML, Conference, or 
Gateway services.
Multiple resources that use a common service type are added to a Logical 
Resource Group so that the Resource Manager can manage the load-balancing 
for the resources within that group.
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This section contains the procedures for creating Logical Resource Groups and 
associated service-types for these groups.

Procedure:
Creating a Logical Resource Group

Purpose:  To combine resources to create a Logical Resource Group for 
components that use a common service type.

Summary

In this procedure, the common service type for the MCPGroup is VoiceXML. If 
you have one or more Call Control Platforms installed as part of your 
deployment, create a CCPGroup using the CCXML service type. You can also 
create a GWGroup or ConfGroup to manage resources that use the Gateway or 
Conference service types. Use the list of options and values in Table 28 to 
configure each Logical Resource Group and type of service.

Note: If you are using external SIP resources, you can create a Logical 
Resource Group, see Appendix C, “External SIP Resources” on 
page 149.

Prerequisites

• The GVP components are installed. See “Installing the GVP Components” 
on page 70.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, click Voice Platform > Resource Management.
3. Highlight the Resource Manager Application object for which you are 

creating the Logical Resource Group.
4. In the Tasks panel, click Manage RM Resources (see Figure 8).

The GVP-Manage <RM Application object> Resources dialog box appears, 
where <RM Application object> is the name of the Application object you 
selected.
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Figure 8: Task Pane—Manage RM Resources

5. Click New.
The New Group dialog box appears.

6. In the Name field, enter the name of the group you want to create—for 
example, MCPGroup.

7. In the remaining fields, enter the information for the service-type you are 
configuring, as shown in Table 28.

Table 28: Options for Logical Resource Groups

Option Name Option Value

VoiceXML or CCXML

Service Type(s) Select value voicexml or ccxml.

Monitoring Method Select values option or none.

load Balance Scheme Select values round-robin or least-used.

Port Usage Type Select value outbound.

Capability Various capabilities are supported—for example, lang=en-US;
grammar=grxml,gsl.
For more information about the supported capabilities for the 
Logical Resource Groups, see the Genesys Voice Platform 8.0 
User’s Guide.

Max. Conference Size This field is disabled.

Max. Conference Count This field is disabled.



102 Genesys Voice Platform 8.0

Chapter 6: Post-Installation Activities on the GVP Hosts Provisioning the Components

8. Click OK.
The MCPGroup appears in the Logical Groups list as shown in Figure 9.

Conference

Service Type(s) Enter value conference.

Monitoring Method Enter values option or none.

load Balance Scheme Select values round-robin or least-used.

Port Usage Type Enter value outbound.

Capability Leave this field empty.

Max. Conference Size Enter value 5. (Expects unsigned integer including zero)
If not defined, is not taken into account.
This parameter is optional.

Max. Conference Count Enter value 10. (Expects unsigned integer including zero).
If not defined there is no limit to the number of conferences for 
this Logical Resource Group.
This parameter is optional.

Gateway

Service-type(s) Enter value gateway.

Monitoring-Method Enter values option or none.

load Balance Scheme Select values round-robin or least-used.

Port Usage Type Enter value in-and-out.

Capability Leave this field empty.

Max. Conference Size This field is disabled.

Max. Conference Count This field is disabled.

noresource-response-code Enter value 500;501.
Expects a list of unsigned integers, delimited by a semicolon.
Corresponds to a SIP response code returned by a gateway when 
the gateway capacity is reached. The Resource Manager retries 
other gateway resources when this response is received.
This parameter is optional.

Table 28: Options for Logical Resource Groups (Continued) 

Option Name Option Value
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Figure 9: Logical Resource Groups—Resource Management

9. Use one of two methods to add resources to the group:
• Click Step 2: Group Resource or, 
• Highlight the MCPGroup and click Next.
A list of resources appears.

10. Click to select the resources you want to add to the group.
11. Enter the Address of Record (AOR) and the maximum number of ports 

(Max.Ports) for this resource as shown in Table 29.
.

Note: If you create a Logical Resource Group for Gateway services, the 
Address of Record (AOR) IP address must be the IP address of the 
gateway resource that interacts with the RM. The interaction can be an 
inbound call to the Resource Manager or an outbound request from the 
Resource Manager to the gateway.

12. Click Next.
13. To confirm the group is complete, click Finish.
14. Repeat steps 3 to 13 to create additional Logical Resource Groups using 

the options in Table 28 on page 101 for each service type.

Table 29: Logical Group Resource Parameters

Name/Value pair Description

aor=sip:<00.00.00.00>:
5060

Address of Record = SIP resource: <IP address>:<port number>.
Each Address of Record (AOR) must include a sip or sips prefix—for 
example, sip:10.0.0.100:5060 or sips:10.0.0.100:5060.

port-capacity=100 Port Capacity = the port capacity of the SIP resource—in this example, 
100.
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Note: For a complete list of parameters that can be configured for the 
Resource Manager, see the Settings tab of the Resource Manager 
Application object properties.

End of procedure

Next Steps

• Continue with the post installation activities for the Resource Manager. See 
“Setting up IVR Profiles and Dialed Number Mapping”.

Setting up IVR Profiles and Dialed Number Mapping

IVR Profiles are VoiceXML and CCXML applications. GVP uses these 
applications to control interactions that use Dialed Numbers (DNs) and 
provides service for them. You can create as many IVR Profiles as required in 
your environment.
Dialed numbers are the DNs obtained from the Dialed Number Identification 
Service (DNIS). The Resource Manager can be configured to obtain DNIS 
information from SIP Server.
If GVP is configured to map of IVR Profiles to DNs, the Resource Manager 
uses DNIS to determine which IVR Profile to invoke for the session.
If GVP is not configured to map of IVR Profiles to DNs, the Resource 
Manager uses a default IVR Profile that is specified for the Environment 
tenant.
This section includes the following procedures:
• Creating IVR Profiles in the Resource Manager, page 104
• Mapping IVR Profiles to Dialed Numbers, page 107
• Adding the Environment Tenant in the Resource Manager, page 109
• Updating the Environment Tenant data, page 110

Procedure:
Creating IVR Profiles in the Resource Manager

Purpose:  To create an IVR Profile in Genesys Administrator for the Resource 
Manager Application object.

Prerequisites

• The GVP components are installed. See Importing Installation Packages 
into the Repository, page 127.
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Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Voice Platform > IVR Profile.
3. Click New to create a new object.

Figure 10: New IVR Profile

4. In the Name and Display Name fields, enter a name for the IVR Profile as 
shown in Figure 10.

5. On the Settings tab, scroll to the gvp.general section.
6. Enter the Values for the Options as shown in Table 30 on page 105.

Note: The service-type option is mandatory in an IVR Profile.

7. Click Apply to save the changes.
8. Click Save.

See Table 31 for other service-type values.

Table 30: Option Names and Values—gvp.general section

Option Name Value

service-type voicexml

sip.sessiontimer 1800

application-confmaxsize 20
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Note: IVR services are provisioned based on the type of functionality the 
application is going to use. The service-type field in the IVR Profile 
specifies which service to invoke.

End of procedure

Next Steps

• Set up Dialed Number Mapping. See Mapping IVR Profiles to Dialed 
Numbers, page 107.

Mandatory IVR Profile Options

Certain parameters are required to ensure that your IVR Profile functions as 
you intend it to function. Table 32 on page 106 contains the mandatory name-
value pairs for each service-type.

Note: The values for VoiceXML and CCXML in Table 32 are only examples. 
Enter the values that indicate where the VoiceXML and CCXML 
Universal Resource Locators (URL) point in your environment.

Table 31: IVR Profile Service Types

Service-type Value

VoiceXML VoiceXML

CCXML CCXML

Conference Conference

Table 32: Mandatory Options—gvp.service-prerequisite Section

Service-
type

Option Name Option Value

VoiceXML initial-page-url file://<local_MCP_install_dir>\samples\helloaudio.vxml
for example, 
file://C:\GVP\VP_MCP\samples\helloaudio.vxml

default-properties-
page

file://<local_MCP_install_dir>\config\defaults-ng.vxml

alternatevoicexml file://<local_MCP_install_dir>\samples\helloaudio.vxml
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Procedure:
Mapping IVR Profiles to Dialed Numbers

Purpose:  To associate IVR Profiles with DNs so that the Resource Manager 
Application object can use DNIS to invoke the required GVP services.

Prerequisites

• The IVR Profiles are created.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Voice Platform > IVR Profile.
3. Select the IVR Profile for which you want to map the DNs.
4. Click the Number Mapping tab.
5. In the menu bar of the tab, click New Rule.

The Specify Dialed Number Mapping Rule dialog box appears as shown in 
Figure 11 on page 108. 

CCXML initial-page-url Enter the URL to your CCXML page.

Conference conference-id 3332

Table 32: Mandatory Options—gvp.service-prerequisite Section (Continued) 

Service-
type

Option Name Option Value
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Figure 11: Specify Dialed Number Mapping Rule

6. In the Minimum and Maximum fields, enter the start and end numbers of the 
DN range. (For a single DN, enter the same number in each field.)

7. From the IVR Profile drop-down list, select required IVR Profile.
8. Click OK.

The new rule appears in the list of mapping rules on the Number Mapping 
tab. The display also includes State column and an icon indicating 
whether the rule is valid or invalid.
A range is valid if each DN in the range is not already specified in another 
mapping rule.

9. To apply the changes, click Apply.
10. Click Save.

End of procedure

Next Steps

• Add the Environment Tenant object to the Resource Manager Application 
object. See Adding the Environment Tenant in the Resource Manager, 
page 109.
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Procedure:
Adding the Environment Tenant in the Resource 
Manager

Purpose:  To add the Environment Tenant object, used to create a default IVR 
application, to the Resource Manager Application object.

Summary

This procedure applies only to Multi-tenant Configuration Server 
deployments. The Environment tenant is not available in Single tenant 
deployments.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Applications.
3. Click the Resource Manager Application object that you want to 

configure.
The Configuration tab appears.

4. In the Tenants field of the Server Info section, click Add.
A Browse dialog box appears.

5. Select Environment and click OK.
The Environment tenant object appears in the Tenants field as shown in 
Figure 12.

Figure 12: Add Environment Tenant object
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6. Click Save.

End of procedure

Next Steps

• Update the Environment Tenant Data. See Updating the Environment 
Tenant data, page 110

Procedure:
Updating the Environment Tenant data

Purpose:  To configure the Environment Tenant so that calls outside of those 
specified in the Dialing Plans are accepted. This procedure configures a default 
IVR application.

Summary

This procedure applies only to Multi-tenant Configuration Server 
deployments. The Environment tenant is not available in Single tenant 
deployments.

Prerequisites

• The GVP components are installed. See “Installing the GVP Components” 
on page 70.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Tenants.
3. Click the Environment tenant.
4. On the Options tab, create a new section named, gvp.general.
5. In the gvp.general section, create a new option named, default-

application.

6. For the default-application option, enter the value IVRAppDefault.
7. Enter the value for the remaining option in Section: gvp.general as shown 

in Table 33.
8. Scroll to gvp.policy section and enter the value for the option as shown in 

Table 33.
9. Scroll to gvp.dnis-range section and enter the values for the options as 

shown in Table 33.
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Note: The default-application option is mandatory for a Tenant.

Note: The gvp.dnis-range values in Table 33 are examples only and are not 
required. Replace these values with values that represent the DNIS 
ranges for your environment, if necessary.

10. Click Apply to save the changes.
11. Click Save.

End of procedure

Next Steps

• Complete the post installation activities for the Reporting Server. See 
“Configuring the Reporting Server User Interface and Options”.

IVR Profile and Environment Tenant Parameters

The gvp.log, gvp.log.policy, and gvp.policy.dialing-rules sections can be 
further defined with many more supported parameters. For a complete list of 
these parameters, check the Settings tab of the Application object template.

Configuring the Reporting Server User Interface and Options
When Genesys Administrator is installed, the Reporting Server User Interface 
(RPTUI) is also installed; however, some parameters in the default 
Application object (or Configuration Server object), such as port numbers, 

Table 33: Section, Name, and Values—GVP options

Section Name Value

gvp.general default-application IVRAppDefault

sip.sessiontimer 1800

gvp.policy usage-limits 100

gvp.dnis-range range3 3500-3505;VXMLApp1

range4 3602;VXMLMusic

range5 4100-4110;VXMLApp2

range6 5000-5010;CCXMLApp1

range7 5109;CCXMLApp2
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authentication, and HTTP settings can be configured to better suit your 
environment.
In addition, a connection to Reporting Server must be created in the default 
Application object to ensure that the RPTUI functions properly. The RPTUI 
discovers the Reporting Server host based on this connection. Furthermore, the 
data reporting limits that are configured in the Reporting Server Application 
object (in Section: reporting) are read and enforced by the RPTUI. See “Next 
Steps” in the procedure, Configuring the Reporting Server user interfaces, 
page 112.
Finally, the Reporting Server logging and messaging parameters are 
configured so that the monitoring and reporting functionality perform as 
intended.

Note: The RPTUI and the logging and messaging parameters are configured 
with default values during the installation of the Reporting Server. 
Therefore, unless your environment is better served by manually 
changing the configuration, the only requirement is to create the 
connection to Reporting Server in the default Application object. See 
“Connecting to a Server” on page 89.

This section contains the following procedures for the default Application 
object and the Reporting Server Application object:
• Configuring the Reporting Server user interfaces, page 112
• Configuring Reporting Server logging and messaging options, page 114

Procedure:
Configuring the Reporting Server user interfaces

Purpose:  To configure the default Application object to ensure the Reporting 
Server user interfaces are exposed and to create the connection to the 
Reporting Server.

Prerequisites

• Genesys Administrator is installed and fully functional. See Framework 
8.0 Deployment Guide.

• The Reporting Server is installed and started. See “Installing the GVP 
Components” on page 70.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Applications.
3. Click the default Application object.
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4. On the Settings tab, click the Reload drop-down list to filter the section 
you want to configure.

5. From the drop-down list, select GVP Reporting.
The list of Settings is filtered and all of the rptui section options appear.

6. Retain or modify the values for the options in the rptui section as shown in 
Table 34.

Note: Click on any option in the Settings tab for a detailed description and 
the default value.

7. Click Save to retain the configuration.

End of procedure

Table 34: default Application object—Settings tab

Option Value

enablehttps Retain the http default value, false.

httpport Retain the default port value, 8080 or
Enter a port number from 1030 to 65535.

httptimeout Retain the timeout value, 30 or
Enter any value greater than 0.

username Enter a username to enable the web server for 
authentication.

password Enter a password to enable the web server for 
authentication.

tzoffset Retain the time zone offset value, -00:00 or
Enter a value in the format shh:mm, where s is either a plus 
(+) or minus (-), hh represents hour, and mm represents 
minutes.

dsthours Retain the default value 01:00 or
Enter a value in the format shh;mm, where s is either a 
plus (+) or minus (-), hh represents hour, and mm 
represents minutes.

localtimeformat Retain the default value true to display the datetime 
fields in local time format, or
Enter false to display the datetime field in Greenwich 
Mean Time (GMT).
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Next Steps

• In the default Application object, create a connection to the Reporting 
Server. See Creating a connection to a server, page 89.

• Configure the logging and messaging options in the Reporting Server 
Application object. See Configuring Reporting Server logging and 
messaging options, page 114.

Procedure:
Configuring Reporting Server logging and messaging 
options

Purpose:  To configure the logging and messaging options in the Reporting 
Server.

Prerequisites

• The GVP components are installed. See “Installing the GVP Components” 
on page 70.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Applications.
3. Click the Reporting Server Application object.
4. On the Settings tab, scroll to the log section.
5. Click the Value field for the debug option.
6. Enter stdout, c:\Programs\<Tomcat_Install_Root>

\webapps\ems-rs

where <Tomcat_Install_Root> is the directory where Jakarta Tomcat is 
installed.

7. Click Apply.
8. Repeat steps 4 to 7 and enter the remaining values in the Log section as 

shown in Table 35.
9. Scroll to the messaging section, and enter the value from Table 35 for this 

section.
10. Scroll to the transaction section, and enter the values from Table 35 for 

this section.
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11. Click Save.

End of procedure

Next Steps

• Create a database for the Reporting Server. See “Creating the Reporting 
Server Databases” on page 115.

Creating the Reporting Server Databases
The GVP 8.0 Reporting Server requires one of two supported relational 
database systems is installed—Microsoft SQL Server 2005, SP2 or Oracle 
10 g. The database and the Reporting Server can share a host or you can install 
the database on a separate host. This section describes how to create the GVP 
reporting database schema.

Before You Begin
Genesys recommends that the GVP Reporting Server is installed before you or 
your database administrator create a database in your Database Management 
System (DBMS).
Ensure that a fully functional instance of the Microsoft SQL Server, SP2 or 
Oracle 10 g exists in your deployment.

Table 35: Reporting Server Options—Settings tab

Section Option Value

log message_format Complete Headers

standard stderr

time_format HH:MM:SS:ss 
(hours, minutes, seconds and milliseconds)

verbose standard

messaging activemq.dataDirectory <Reporting_Serv_Dir>\data\activemq

transaction atomikos.log.dir <Reporting_Serv_Dir>\logs

atomikos.working.dir <Reporting_Serv_Dir>\data\Atomikos
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Note: This section describes the creation of the database schema only. The 
setup of the Microsoft SQL Server or Oracle 10 g instances is outside 
the scope of this document. For information about setting up these 
instances, check the vendor documentation.

Setting Up the Database
This section provides the following generic procedures to create the database 
schemas:
• Setting up a database for the Reporting Server, page 116
Table 36 on page 116 contains the paths to the scripts used to create the 
respective database schemas.

Procedure:
Setting up a database for the Reporting Server

Purpose:  To create a database and schema for the Reporting Server.

Summary

The Reporting Server databases must be set up to support XA transactions—by 
default, Microsoft SQL Server does not. Instructions are available on the 
Microsoft web site that describe how to set up support for XA in SQL Server.
Many query tools can be used by SQL Server and Oracle 10 g to execute SQL 
scripts. For example, Management Studio is included in Microsoft SQL 
Enterprise edition and Oracle SQL Developer is available on the Oracle web 
site.
Microsoft cumulative update packages for SQL Server contain the most recent 
hot fixes and security fixes. Ensure that the hot fix listed as a prerequisite for 
this procedure is included in the Service Pack you have installed.

Prerequisites

• Microsoft SQL hot fix build 3175 must be installed.

Table 36: Database Script Files

Script File Default Path

mssql_schema.sql <Reporting_Serv_Install_Dir>\scripts 

oracle_schema.sql <Installation_Directory>\Program 
Files\GCTI\gvp\VP Reporting Server 
8.0\RS_MSSQL38\scripts
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• Microsoft SQL Server 2005, SP2 is set up to support XA transactions.
• Microsoft SQL Server Management Studio development tool is installed 

on the SQL Server.
• Sun JDK 6, Update 5 is installed.

Note: If the database and Reporting Server are sharing a host, ensure that the 
Tomcat application server (a prerequisite for the Reporting Server) is 
not set to run automatically. When installing Tomcat, users should 
select No for this option when prompted by the installation wizard.

Start of procedure

1. In the directory where Reporting Server is installed, open the scripts 
folder.
See Table 36 for the list of DBMS and the corresponding name and 
location of the initialization script files.

2. Open the folder that matches your database type.
3. Load and execute the initialization script that corresponds to your DBMS.

End of procedure

Next Steps

• No further steps are required.



118 Genesys Voice Platform 8.0

Chapter 6: Post-Installation Activities on the GVP Hosts Creating the Reporting Server Databases



Deployment Guide 119

Chapter

7 Maintaining GVP
This chapter describes how to stop, start, and uninstall Genesys Voice Platform 
(GVP) components.
It contains the following sections:

Starting and Stopping GVP, page 119
Uninstalling GVP Components, page 121

Starting and Stopping GVP
Use Genesys Administrator to safely and easily start, stop, and gracefully stop 
each of the GVP components or a GVP Solution object. A graceful stop causes 
the Application or Solution object to stop accepting new requests, and finish 
processing those requests that it currently has in its queue.
This section contains the following procedures:
• Starting and stopping GVP Solution objects, page 119
• Starting and stopping GVP Application objects, page 120

Procedure:
Starting and stopping GVP Solution objects

Purpose:  To describe the ways in which you can start or restart the GVP 
Solution objects.

Prerequisites

• The GVP components are installed. See “Installing the GVP Components” 
on page 70.

• A Solution object is created. See Creating a Resource Solution object, 
page 83.
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Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Solutions.
3. Select the Solution object you want to start.
4. In the Tasks panel, click the Runtime section down arrow.

The section opens to display the start and stop options as shown in 
Figure 13.

5. Select one of these three options; Start, Stop, or Graceful Stop.

End of procedure

Next Steps

• No further steps are required.

Figure 13: Task Panel—Stop/Start Solution

Procedure:
Starting and stopping GVP Application objects

Purpose:  To describe the ways in which you can start or restart the GVP 
Application objects.

Prerequisites

• The GVP components are installed. See “Installing the GVP Components” 
on page 70.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Applications.
3. Select the Application object you want to start or stop.
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4. In the Tasks panel, click the Runtime section down arrow as shown in 
Figure 14.
A list of options appear.

5. Select one of three options; Start, Stop, or Graceful Stop.

End of procedure

Next Steps

• No further steps are required.

Figure 14: Task Panel—Stop/Start Application

Uninstalling GVP Components
You must uninstall the GVP components one at a time, and in the reverse order 
of installation. Before you begin to uninstall the Application objects, ensure 
that they are stopped by using the Stop applications gracefully option in 
Genesys Administrator.

Note: If you used the installation sequence in the Task Summary table in 
Chapter 3, “Deployment Task Summary,” on page 51, use the reverse 
sequence to uninstall GVP.

Procedure:
Uninstalling GVP components manually

Purpose:  To uninstall the GVP manually one component at a time.

Summary

You must uninstall each component while you are logged on to the host 
machine.
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Prerequisites

• The Application objects to be uninstalled are stopped by using the Stop 
applications gracefully option in Genesys Administrator. See Starting 
and stopping GVP Application objects, page 120.

Start of procedure

1. From the Start menu, select Control Panel > Add/Remove Programs.
2. Select the appropriate GVP component from the list of currently installed 

programs. 
3. Click Remove.
4. When the uninstall is complete for each of the GVP components, restart 

the machine.

End of procedure

Next Steps

• There are no further steps required.
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Part

3 Appendixes
This part of the Deployment Guide contains miscellaneous information in the 
following appendixes:

Appendix A, “Installing GVP Using the Deployment Tool,” on page 125
Appendix B, “NLB Clustering for Resource Manager,” on page 137
Appendix C, “External SIP Resources,” on page 149
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Appendix

A Installing GVP Using the 
Deployment Tool
This appendix describes how to deploy and provision the Genesys Voice 
Platform (GVP) using the Genesys Administrator Deployment tool. 
It includes a task summary of various deployment tasks for a GVP installation 
using the Deployment tool, and provides links to detailed information about 
the required tasks.
This appendix contains the following sections:

Task Summary, page 125
Installing GVP in Genesys Administrator, page 127

Task Summary
Before you begin to deploy the Genesys Voice Platform, ensure that you have 
prepared the GVP hosts for installation and that the pre-installation activities 
are completed. Use the Task Summary in Table 37 to guide you in the order of 
tasks to complete.

Note: Install GVP components on a host separate from the Genesys 
Administrator web server host. Installing some GVP components can 
stop the web server momentarily. If the web server does not run 
continuously, the Genesys Administrator Deployment tool indicates 
the deployment is incomplete.

Table 37 on page 126 summarizes the steps that are required to install GVP in 
a Windows environment, using the Genesys Administrator Deployment tool.
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Table 37: Task Summary—Installing GVP with the Deployment Tool

Objective Related Procedures and Actions

Plan the deployment. For specific restrictions and recommendations to consider, see 
“Host Setup” on page 45.

Prepare your environment. For the tasks required to prepare you environment, see 
Table 9 on page 51.

Prepare the GVP host(s). For the tasks required to prepare the GVP host(s), see Table 9 
on page 51.

Stop antivirus software that may be 
running on systems that will host GVP 
components.

For information about how to configure the antivirus 
software, check the vendor documentation.

Install GVP. 1. Import the GVP Installation Packages into the 
Deployment tool Repository.

See Importing Installation Packages into the Repository, 
page 127.

2. Create a Deployment Scenario that contains a GVP 
Solution object.

See Populating a deployment Scenario, page 130.

3. Validate the Deployment Scenario before the GVP 
Solution object is installed.

See Validating the deployment Scenario, page 132.

Perform the post-installation activities: For the post-installation activities to provision the GVP 
components for the functionality you want use in your 
deployment, see Table 9 on page 51.

Set up the Reporting Server database. Install the database. See “Creating the Reporting Server 
Databases” on page 115.
For supported databases and versions, see “Prerequisites” on 
page 42.
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Installing GVP in Genesys Administrator
In Genesys Administrator, the Genesys Voice Platform (GVP) components are 
deployed all at once as a Solution object or individually by choosing one or 
more GVP Installation Packages.

Using the Deployment Tool
When the Genesys Administrator Deployment tool is used to deploy GVP the 
Installation Packages are imported to the Genesys Administrator Repository 
and are used to populate a deployment Scenario. The Scenario contains the 
GVP Application objects—selected from the Genesys Administrator 
Repository—that make up a Solution object. Each component in the Solution 
object is assigned to a host and is validated before installation. You can create a 
new Scenario, select a pre-existing Scenario, or select a single Installation 
Package from the Repository and deploy it by using a drag-and-drop method.

Before You Begin

Before you begin the deployment, ensure that there are no previous instances 
of the components on the target host(s). If there is a previous instance of a 
component present on the host, the deployment fails, but the error message 
indicates Command Executed Successfully. In fact, the command that is 
executed is an uninstallation process and the component is no longer installed.
In addition, when you populate a deployment Scenario, ensure that the 
Fetching Module is first in the list of components. The Fetching Module must 
be installed before the Media Control Platform and the Call Control Platform. 
If the Fetching Module is already installed on the host(s), do not include it in 
the Scenario.
This section contains the following procedures:
• Importing Installation Packages into the Repository on page 127
• Populating a deployment Scenario on page 130
• Using an existing Scenario to deploy GVP on page 131
• Validating the deployment Scenario on page 132

Procedure:
Importing Installation Packages into the Repository

Purpose:  To import the Installation Packages into the Repository before 
installing GVP as a Solution object with all components on a single host with 
basic configuration.
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Prerequisites

• Management Framework is installed using the Multi-tenant Configuration 
Server and is fully operational. See the Framework 8.0 Deployment Guide.

• Jakarta Tomcat 6.0.16, and Sun JDK 6, Update 5 are installed on the 
Reporting Server host.

• A new host is added in the Configuration database for each GVP host. See 
Adding a new GVP host in Genesys Administrator, page 60.

• The LCA is installed on the GVP host(s). See Installing the Local Control 
Agent on a GVP host, page 61.

• The Squid caching proxy is installed on the Media Control Platform and 
Call Control Platform. See Installing the Squid caching proxy, page 70.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Deployment tab, click Repository > Installation Packages > 

Import.

The Installation Packages Import Wizard dialog box appears as shown in 
Figure 15.

Figure 15: Genesys Administrator Installation Packages Import Wizard

3. If you choose Installation CD ROM:
a. Click Next.
b. In the CD Source field, enter the path, 

• To the folder that contains the CDInfo.xml file or, 
• To the network directory that contains the CDInfo.xml file.
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Note: When you enter the path to a network directory, do not include a 
mapped drive letter with a $ symbol. Enter the path without the drive 
letter—for example, \\Installation_Pkgs\gvp80\.

c. Click Next.
The Installation Packages Repository appears in the Step3: Select 
Items dialog box.

d. Select the Installation Package that you want to import.
e. Click Next.

The Step 4: Process import dialog box appears with a progress bar as 
the wizard begins to import the package.

f. After the Installation Package is imported, click Finish.
g. Repeat steps 2 to 9 to import additional Installation Packages.

4. If you choose Single Installation Package:
a. Click Next.
b. In the IP Source field, enter the path, 

• To the folder that contains the ip_description.xml file or, 
• To the network directory that contains the ip_description.xml file.

c. In the Template Folder field, enter the path,
• To the Templates folder on the CD or,
• To the Templates folder in a network directory.

d. Click Next.
The Installation Packages Repository appears in the Step3: Select 
Items dialog box.

e. Select the Application object template that you want to install.
f. Click Next.

The Step 4: Process import dialog box appears with a progress bar as 
the wizard begins to import the package and template.

g. After the Installation Package is imported, click Finish.
h. Repeat steps 2 to 9 to import additional Installation Packages.

End of procedure

Next Steps

• Populate a deployment Scenario. See Populating a deployment Scenario, 
page 130.
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Procedure:
Populating a deployment Scenario

Purpose:  To populate a Scenario to include all of the Application objects 
required for your deployment.

Summary

This procedure describes how to install the GVP components as a Scenario on 
a single host, however, you can include more than one Media Control Platform 
or Call Control Platform component to your deployment scenario.

Note: Genesys supports only one instance of an Application object per 
host—for example, if you are deploying two Media Control Platform 
components, they must be deployed to separate hosts.

Prerequisites

• The Installation Packages have been imported to the Repository. See 
Importing Installation Packages into the Repository, page 127.

Start of procedure

1. In the Navigation panel, click Deploy > Deploy GVP.
2. In the Deployment Scenario panel, click Add Application.
3. In the Select application dialog box, select the Application objects you 

want to add to the Scenario.

Note: To select multiple Application objects at once, hold down the Ctrl 
key on your keyboard and click to highlight each Application 
object you want to add to the Scenario. Ensure the Fetching 
Module is first in the list of components.

4. Click Add.
The Application objects appear under the Solution object as shown in 
Figure 16.

5. Select the Scenario or a single Application object; drag and drop it on the 
target host.
The Scenario or Application object appears under the target host.

Note: If you have targeted an incorrect host, highlight the incorrect host 
and select Reassign. The Scenario or Application object moves 
back to the Scenario pane.



Deployment Guide 131

Appendix A: Installing GVP Using the Deployment Tool Installing GVP in Genesys Administrator

Figure 16: GVP Deployment Scenario

End of procedure

Next Steps

• Validate the deployment Scenario. See Validating the deployment 
Scenario, page 132.

Procedure:
Using an existing Scenario to deploy GVP

Purpose:  To deploy GVP by using an existing Scenario.

Summary

If a Scenario exists and is already populated with all of the Installation 
Packages you require, it can be used to deploy GVP.

Prerequisites

• Management Framework is installed and fully operational. See the 
Framework 8.0 Deployment Guide.

• Jakarta Tomcat 6.0.16, and Sun JDK 6, Update 5 are installed on the 
Reporting Server host.

• A new host is added in the Configuration database for each GVP host. See 
Adding a new GVP host in Genesys Administrator, page 60.

• The LCA is installed on the GVP host(s). See Installing the Local Control 
Agent on a GVP host, page 61.
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• The Squid caching proxy is installed on the Media Control Platform and 
Call Control Platform. See Installing the Squid caching proxy, page 70.

Start of procedure

1. In the Navigation panel, click Deploy > Deploy GVP.
2. In the Deployment Scenario panel, click New.

A New deployment scenario dialog box appears.
3. Click Yes.
4. In the Deployment Scenario pane, select the Scenario you want to use and 

drag and drop it on the target host.
The Scenario appears under the target host.

Note: If you have targeted an incorrect host, highlight the incorrect host and 
select Reassign. The Scenario moves back to the Scenario pane.

End of procedure

Next Steps

• Validate the deployment Scenario. See Validating the deployment 
Scenario, page 132.

Procedure:
Validating the deployment Scenario

Purpose:  To validate the deployment Scenario to ensure the connections are 
active before installation occurs.

Prerequisites

• A deployment Scenario is populated. See Populating a deployment 
Scenario, page 130.

Summary

The Deployment tool validates only those components in the Solution object 
that are assigned to a host. If you have components in the Solution object that 
are not assigned, remove them before validation.

Start of procedure

1. In the Navigation panel, click Deploy GVP > Validate.
The Deployment Scenario Validation Wizard appears with heading 
VPSolution_CCP in the right panel.
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2. Enter the information from Table 38, clicking Next after each entry.
See Figure 17 on page 134 for an example of the VPSolution Reporting 
Server panel with fields populated.

Table 38: Deployment Scenario Validation Wizard

Panel Field Description and Value

VPSolution_FM workDirectory Enter the path to the installation directory for the Fetching 
Module—for example, <Installation_Directory>\fm\bin.

VPSolution_CCP workDirectory Enter the path to the installation directory for the Call Control 
Platform—for example, <Installation_Directory>\ccp\bin.

Host Enter the host name for the Reporting Server.

Port Enter the port number for the Reporting Server—typically 
61616.

VPSolution_MCP workDirectory Enter the path to the installation directory for the Media Control 
Platform—for example, <Installation_Directory>\mcp\bin.

InstallMode From the drop-down list:
• Select mulaw in North America or,
• Select alaw in Europe.

Host Enter host name for the Reporting Server.

Port Enter the port number for the Reporting Server—typically 
61616.

VPSolution_
ReportingServer

workDirectory Enter the path to the installation directory for the Reporting 
Server—for example, <Installation_Directory>\rs\bin.

JavaPath Enter the path to the installation directory for the Java Runtime 
Environment on the local host—for example, 
C:\j2sdk1.4,2_07\jre.

Engine Select the database engine that you are using in your 
deployment—for example, MSSQL:

ServerName Enter the database server name.

Host Enter the host name of the server that is hosting the database.

Port Enter the port number for the database server—typically 1433.

User Enter a user name for authentication—typically sa.

Password Enter a password for authentication—typically password.
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3. Click Next.
The Validation complete heading appears in the right panel.

4. To exit the wizard, click Finish.

Figure 17: Validation Wizard—Reporting Server panel

5. After the validation is complete, click Save.
The Save Deployment Scenario dialog box appears.

6. In the File name field, enter a file name for the Scenario.
7. Click Save.
8. To verify that the information for the deployment is correct, click the 

Details tab.
9. If anything is changed in the Scenario at this point, validate the 

deployment again.

VPSolution_
ReportingServer 
(continued)

Port Enter the port number for the Reporting Server—typically 
61616.

VPSolution_
ResourcManager

workDirectory Enter the path to the installation directory for the Resource 
Manager—for example, <Installation_Directory>\rm\bin.

Host Enter the host name for the Reporting Server.

Port Enter the port number for the Reporting Server—typically 
61616.

Table 38: Deployment Scenario Validation Wizard (Continued) 

Panel Field Description and Value
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10. When you are satisfied that the Scenario is correct, click Deploy.
The Results tab appears with a progress bar (see Figure 18 on page 135). 
The Deployment tool delivers the Installation Packages to the target 
host(s) and installs the components, which are then configured in 
Configuration database.

11. After the deployment is complete, click the Summary tab to view a summary 
of the Application objects configuration.

Figure 18: Results Tab of Deployment Tool 

End of procedure

Next Steps

• Complete the Post Installation procedures. See Chapter 6, “Post-
Installation Activities on the GVP Hosts,” on page 81.
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Appendix

B NLB Clustering for 
Resource Manager
This appendix describes how to configure the Genesys Voice Platform (GVP) 
Resource Manager hosts, and Genesys Management Framework to create a 
Network Load Balancing (NLB) cluster.
It contains the following sections:

Overview, page 137
NLB Clustering Service, page 137

Overview
When the Resource Manager is clustered, the Resource Manager function is 
distributed over more than one computer. Incoming IP traffic is load-balanced 
across NLB clusters to achieve high availability and scalability. The 
management capabilities and computing power of the Resource Manager are 
increased by adding more processors or hosts to the cluster.
Clusters prevent single point-of-failure and provide immediate failure 
recovery, which enhances availability. In addition, an administrator manages 
the cluster as a single system locally or remotely.

NLB Clustering Service
This section describes how to create an NLB cluster on the Resource Manager 
hosts and create the Cluster Manager Application object in the Configuration 
database by using the following procedures:
• Setting up an NLB cluster, page 138
• Creating a Cluster Manager Application object, page 141
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• Configuring cluster mode in the Resource Manager, page 143
• Configuring the INIT and NLB script files, page 144
• Specifying the NICs for monitoring, page 146

Before You Begin

Before you begin the procedures in this section, ensure the Resource Manager 
hosts:
• Are configured and fully functional in stand-alone mode.
• Reside on the same subnet.
• Each have at least two Network Interface Cards (NIC) configured with 

unique IP addresses (within the same subnet).
In addition, allocate a virtual IP address to be used in the procedure, “Setting 
up an NLB cluster”.

Note: SNMP MIBs function properly when there is only one instance of a 
GVP component on a host. Using the SNMP MIBs on a server that is 
hosting more than one instance of the Resource Manager is not 
recommended.

Procedure:
Setting up an NLB cluster

Purpose:  To set up an NLB cluster by configuring Windows.

Summary

Perform this procedure on each of the Resource Manager hosts in the NLB 
cluster:

Prerequisites

• The Resource Manager hosts conform to the prerequisites for Windows. 
See “Prerequisites” on page 42.

• Management Framework is installed, and fully functional. See Framework 
8.0 Deployment Guide.

Start of procedure

1. At the Windows Start menu, click Control Panel > Network 
Connections.

2. Right-click the Local Area Connection that will be used for NLB 
clustering.
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3. Select Properties.
The General tab of the Local Area Connection appears.

4. In the list of services:
• Ensure that Network Load Balancing is selected or,
• If NLB is not in the list, click Install > Service > Network Load 

Balancing.

5. With Network Load Balancing highlighted on the General tab, click 
Properties.

6. Enter the information in Table 39 to configure the Cluster Parameters and 
Host Parameters tabs.

Table 39: Properties of NLB service

Section Field Description

Cluster Parameters

Cluster IP 
configuration

IP Address Enter the virtual IP address for this cluster.

Subnet mask Enter the subnet mask for your network.

Full Internet name Enter the Fully Qualified Domain Name (FQDN) 
associated with the virtual IP address.

Cluster operation mode Unicast Click the radio button to enable.

Allow remote control
(ensure that this is 
checked)

Remote password Enter root1 for the remote password.

Confirm password Enter root1 to confirm the password.

Host Parameters

Priority (unique host identifier) Enter 1 for the first Resource Manager host in the 
cluster.
Enter 2 for the second Resource Manager host in 
the cluster.

Dedicated IP 
configuration

IP address Enter the IP address associated with this Local 
Area Connection.

Subnet mask Enter the subnet mask for the network.

Initial host state Default state From the drop-down list, select Started.

Retain suspended 
state after 
computer starts

Leave the check box empty.
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7. On the Port Rules tab, click Add.
The Add/Edit Port Rule dialog box appears.

8. Enter the information for the Port rules as shown in Table 40.

9. Click OK to save the port rules.
10. Click OK to save the changes to the NLB properties.
11. On the General tab, highlight Internet Protocol (TCP/IP).
12. Click Properties.
13. Verify that the settings on the General tab are those associated with this 

Local Area Connection.
14. Click the Advanced tab.
15. The Advanced TCP/IP Settings dialog box appears.
16. In the IP addresses field, verify:

• That the first IP address is the one associated with the Local Area 
Connection and

• That the second IP address is the virtual IP address.
17. Click OK to save the settings.

Initial host state 
(continued)

Single host Leave empty.

Disable this port 
range

Leave empty.

Table 39: Properties of NLB service (Continued) 

Section Field Description

Table 40: Add/Edit Port Rule

Section Field Description

Cluster IP address Enter a check mark to select All.

Port range From Accept the default, 0.

To Accept the default, 65535.

Protocols Select Both.

Filtering mode Multiple hosts Click the radio button to enable.

Affinity Click the radio button to select None.

Load weight Enter a check mark to select Equal.

Single host Leave empty.

Disable this port range Leave empty.
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18. Click OK to close the Local Area Connection Properties dialog box.
19. Reboot the computer.

End of procedure

Next Steps

• Create a Cluster Manager Application object. See Creating a Cluster 
Manager Application object, page 141.

Procedure:
Creating a Cluster Manager Application object

Purpose:  To create the Cluster Manager Application objects for the Resource 
Manager host.

Summary

Create a Cluster Manager Application object for each Resource Manager host 
in the cluster.

Prerequisites

• A Cluster Manager Application object template is imported to the 
Configuration Database. See Importing Application object templates to the 
Configuration database, page 63.

Start of procedure

1. Log in to Genesys Administrator.
2. Follow the steps in Creating Application objects in the Configuration 

database on page 68 to create the Cluster Manager Application objects.
3. In the Server Info section, replace the information for the Working 

Directory, Command Line, Command line arguments, and Auto Restart 
fields, with the information shown in Table 41.

Table 41: Cluster Manager Application Object Properties

Field Description

Working Directory: Enter <Res_Mgr_Install_Dir>\bin
where <Res_Mgr_Install_Dir> is the root of the binary directory.

Command Line: Enter clustermgr.exe.
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4. Click Apply to save the configuration data.
5. On the settings tab, enter the mandatory information as shown in 

Table 42.

Command line arguments Enter -host <config-host> -port <config-port>
-app <application_name> -lms <Installation 
Directory>\config\CM_EMSMF.lms where:
<config-host> is the name of the host on which the Configuration server 
resides.
<config-port> is the port number for the Configuration server.
<application_name> is the name of the Cluster Manager Application 
object—for example, ClusterMgr1 or ClusterMgr2.
<Installation Directory> is the directory where the .lms file is installed.

Auto Restart Select True to enable.

Table 41: Cluster Manager Application Object Properties (Continued) 

Field Description

Table 42: Cluster Manager Options

Section Option Name Value

Cluster members Accept default value 1 2.

member.1 Enter <host_IP_add_1>:9801
where <host_IP_add_1> is the IP address of the first Resource 
Manager host in the cluster.

mymemberid For the Cluster Manager Application object that represents the 
first Resource Manager host in the cluster, enter 
My Member ID: 1.
For the Cluster Manager Application object that represents the 
second Resource Manager host in the cluster, enter 
My Member ID: 2.
The first and second Resource Manager hosts must correspond to 
the first and second Resource Manager hosts that were specified 
in Table 39 on page 139.

Cluster member.2 Enter <host_IP_add_2>:9801
where <host_IP_add_2> is the IP address of the second Resource 
Manager host machine in the cluster.

NLBScriptPath Enter <Installation Directory>\bin\NLB.bat
where <Installation Directory> is the directory where the 
NLB.bat file is installed.
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Note: Many other options can be configured for the NLB cluster nodes. 
For a complete list and description of the available options, see the 
Settings tab of the Cluster Manager Application object.

6. Click Save.
7. Repeat the steps in this procedure for each Cluster Manager Application 

object in the cluster.

End of procedure

Next Steps

• Create a connection to the Message Server for each of the Cluster Manager 
Application objects in the cluster. See Creating a connection to a server, 
page 89.

• Configure cluster mode in each Resource Manager Application object in 
the cluster. See Configuring cluster mode in the Resource Manager.

Procedure:
Configuring cluster mode in the Resource Manager

Purpose:  To configure the Resource Manager Application objects to execute in 
cluster mode.

Summary

Configure cluster mode on each Resource Manager Application object in the 
cluster.

Prerequisites

• The Resource Manager Application objects are created and fully 
functional. See “Before You Begin” on page 138.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Applications.
3. Select the Resource Manager Application object you want to configure in 

cluster mode.
4. On the Settings tab, enter the Values for each Option as shown in Table 43.
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5. Click Save.
6. Repeat the steps in this procedure for each Resource Manager Application 

object in the cluster.

End of procedure

Next Steps

• Configure the INIT.bat and NLB.bat script files.

Procedure:
Configuring the INIT and NLB script files

Purpose:  To configure the INIT.bat and NLB.bat files with the virtual IP 
address for the cluster.

Summary

Configure the INIT.bat and NLB.bat files on each Resource Manager host in 
the cluster.

Prerequisites

• NLB clustering has been set up on the hosts. See Setting up an NLB 
cluster, page 138.

• The Cluster Manager Application objects are created. See Creating a 
Cluster Manager Application object, page 141.

• Cluster mode is configured in the Resource Manager Application objects. 
See Configuring cluster mode in the Resource Manager, page 143.

Start of procedure

1. Open the INIT.bat file in a text editor.
The INIT.bat file is found in <Res_Mgr_Install_Dir>\bin.

Table 43: RM Application Object Options

Section Option Value

rm cluster_ip Enter the virtual IP address for this cluster.

proxy sip.transport.0 Enter transport0 udp:any:5070.

sip.transport.1 Enter transport1 tcp:<virtual_IP_cluster>:5070
where <virtual_IP_cluster> is the virtual IP address for 
the cluster.
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2. In the scripts,
wlbs disable 5060 <virtual _ip_addr>:1 /PASSW root1

wlbs disable 5060 <virtual _ip_addr>:2 /PASSW root1

replace <virtual _ip_addr> with the virtual IP address—for example:
wlbs disable 5060 138.120.84.236:1 /PASSW root1

wlbs disable 5060 138.120.84.236:2 /PASSW root1

3. Click File > Save.
4. Open the NLB.bat file in a text editor.

The NLB.bat file is found in <Res_Mgr_Install_Dir>\bin.
5. In the script,

wlbs %1 9999 <virtual _ip_addr>:%2 /PASSW root1

if ERRORLEVEL 1 exit /B 0

exit %ERRORLEVEL%,

replace <virtual _ip_addr> with the virtual IP address—for example:
.wlbs %1 9999 138.120.84.236:%2 /PASSW root1

6. Click File > Save.
7. Execute the INIT.bat and NLB.bat files to ensure they are working.

End of procedure

Next Steps

• Specify the NICs you want to monitor. See “Monitoring the NICs in 
Cluster Mode” on page 145 (optional).

Monitoring the NICs in Cluster Mode

Cluster Manager monitors the Network Interface Cards (NIC) in cluster mode 
to determine network error instances, such as when a cable is unplugged. If any 
of the NICs encounter errors, the Cluster Manager considers the network 
down.
To ensure that the NLB cluster works properly, two NICs must be monitored 
by Cluster Manager—one with NLB cluster configured and one with the IP 
address of the host machine.
When there are more than two NICs present in the system and the other NICs 
are not part of the NLB cluster, it is recommended that you specify the MAC 
addresses of the NICs that you want to monitor.
Use the steps in Specifying the NICs for monitoring to specify the NICs you 
want to monitor.
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Procedure:
Specifying the NICs for monitoring

Purpose:  To specify the NICs that are to be monitored by the Cluster Manager.

Prerequisites

• More than two NICs are configured on the same host and are fully 
functional.

• Two NICs are configured as part of a cluster. See Setting up an NLB 
cluster, page 138 and Creating a Cluster Manager Application object, 
page 141.

Start of procedure

1. Log in to Genesys Administrator.
2. On the Provisioning tab, select Environment > Applications.
3. Select the Cluster Manager Application object you want to configure.
4. On the Settings tab, scroll to the gvp section.
5. Scroll to the nic.eth0 option.
6. In the Value field, enter the MAC address for the first NIC you want to 

monitor.
7. Repeat steps 5 to 8, entering these values:

• Name = nic.eth1
• Value = the MAC address for the second NIC you want to monitor.

8. Click Save.
9. To confirm you have configured the NICs correctly, use the command, 

ipconfig/all to query the MAC addresses of the NICs.

End of procedure

Next Steps

• Execute NLB cluster mode. See “Executing NLB cluster mode”.

Executing NLB cluster mode

Before you execute NLB cluster mode:
• Execute the INIT.bat file—when you execute this file, load balancing is 

disabled on all members in the cluster, except Cluster Manager. Once load 
balancing is controlled by Cluster Manager, it detects the health of the 
Resource Manager before executing in cluster mode.
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• Start one instance of the Cluster Manager Application object and one 
instance of the Resource Manager Application object on each host in the 
cluster.

• Ensure that each host is running different instances of the Cluster Manager 
and Resource Manager Application objects—for example, one host is 
running ClustMgr1 and ResMgr1 and another host is running ClustMgr2 and 
ResMgr2.
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C External SIP Resources
This appendix describes how to configure the Genesys Voice Platform (GVP) 
to communicate with external SIP resources.
It is not necessary to configure the Voice Platform Solution (VPS) to include 
external SIP resources, except under certain conditions. If you have questions 
about when or how to use external SIP resources in your deployment, contact a 
Genesys Technical Support Representative for more information.
This appendix contains the following section:

Configuring External SIP Resources, page 149

Configuring External SIP Resources
To create a Application object for an external SIP resource, you must create an 
Application object in the Configuration Database and the connection that 
facilitates communication between the external gateway and Resource 
Manager.
This section contains the following procedures:
• Creating an Application object for an external SIP resource on page 149
• Creating a connection for external SIP resource on page 150
• Creating a Logical Resource Group for external SIP resources on page 151

Procedure:
Creating an Application object for an external SIP 
resource

Purpose:  To create a External_SIP_Resource Application object in the 
Configuration database for an external SIP resource to which calls are routed if 
the request-uri from the platform does not match Gateway services.
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Summary

Creation of an External_SIP_Resource Application object in the Configuration 
database differs slightly from the creation of other Application objects in that, 
you do not need to import the Application object template as the first step. The 
Gateway Application object template is imported automatically when the 
Resource Manager component is deployed and is used to create the 
External_SIP_Resource Application object.

Prerequisites

• The Resource Manager Application object is installed with basic 
configuration. See Installing Resource Manager, page 76.

Start of procedure

1. Follow steps 1 to 3 in the procedure, Creating a Gateway Application 
object in the Configuration database, page 96.

2. In step 4 of that procedure, name the Application object 
External_SIP_Resource.

3. Follow the remaining steps in the procedure to the end.

End of procedure

Next Steps

• Create a connection in the Resource Manager for the 
External_SIP_Resource Application object. 

Procedure:
Creating a connection for external SIP resource

Purpose:  To create a connection to the Resource Manager to facilitate 
communication with the External_SIP_Resource Application object.

Prerequisites

• The Resource Manager Application object is installed. See Installing 
Resource Manager, page 76.

• An External_SIP_Resource Application object is created in the 
Configuration Database. See Creating an Application object for an external 
SIP resource, page 149.
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Start of procedure

1. Follow steps 1 to 5 in the procedure, Creating connections in the Resource 
Manager Application object, page 98.

2. In step 6 of that procedure, select the External_Resource Application 
object.
The required fields (those with an asterisk) in Connection Info populate 
automatically.

3. Click OK.
The External_SIP_Resource Application object appears under 
Connections.

4. Click Apply.
5. Click Save.

End of procedure

Next Steps

• Create a Logical Resource Group for components that use external SIP 
resources. See Creating a Logical Resource Group for external SIP 
resources, page 151.

Setting up External SIP Resource Types

In Resource Manager, you can set up a resource type by creating a Logical 
Resource Group that consists of two or more components that need access to a 
common type of service, such as external SIP resource services.
Multiple resources, that use a common service type, are added to a Logical 
Resource Group so that the Resource Manager can manage the load-balancing 
for the resources within that group.
This section contains the procedures for creating a Logical Resource Group for 
the external SIP resources and the associated service-types for this group.

Procedure:
Creating a Logical Resource Group for external SIP 
resources

Purpose:  To combine resources to create a Logical Resource Group for 
components that use a common service type.
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Summary

In this procedure, the common service type for the ExtSIPGroup is External-
SIP. 

Note: Use the list of options and values in Table 28 on page 101 to configure 
other types of Logical Resource Group that use a common service-
type.

Prerequisites

• The GVP components are installed. See “Installing the GVP Components” 
on page 70.

Start of procedure

1. Follow steps 1 to 5 in the procedure, Creating a Logical Resource Group, 
page 100.

2. In step 6 of that procedure, in the Name field, enter the name of the group 
you want to create—for example, ExtSIPGroup.

3. In the remaining fields, enter the information for the service-type you are 
configuring, as shown in Table 44.

Table 44: Options for the ExtSIPGroup Logical Resource Group

Option Name Option Value

External-SIP

Service-type(s) Enter value external.

Monitoring-Method Enter values option or none.

load Balance Scheme Select values round-robin or least-used.

Port Usage Type Enter value in-and-out.

Capability Leave this field empty.

Max. Conference Size This field is disabled.

Max. Conference Count This field is disabled.

noresource-response-code Enter value 500;501.
Expects a list of unsigned integers, delimited by a semicolon.
Corresponds to a SIP response code returned by a gateway when the 
gateway capacity is reached. The Resource Manager retries other 
gateway resources when this response is received.
This parameter is optional.
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4. Follow steps 8 to 13 in the procedure, Creating a Logical Resource Group, 
page 100 replacing MCPGroup with ExtSIPGroup.

Note: For a complete list of parameters that can be configured for the 
external SIP resources, see the Settings tab of the 
Externa_SIP_Resource Application object properties.

End of procedure

Next Steps

• No further steps are required.
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